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Introduction
Microsoft Visio 2013 is the premier application for creating business and technical diagrams. 
Far more than a drawing program, Visio is used by millions of people to document the physi-
cal world and to convey concepts and data in a visual format.

Microsoft Visio 2013 Step by Step offers a comprehensive look at both the Standard and 
Professional editions of Visio 2013. By following the exercises in the book, you will learn 
about important product features by working with them rather than just reading about 
them. You will also explore the powerful integration between Visio and other members 
of the Microsoft Office suite of applications, including Microsoft SharePoint 2013 and 
SharePoint Online.

Who this book is for
Microsoft Visio 2013 Step by Step and other books in the Step by Step series are designed 
for beginning to intermediate level computer users. The examples and exercises in this book 
apply equally well in small, medium, and large organizations, whether their orientation is 
commercial, governmental, academic, or non-profit. Many examples teach skills that can 
be applied for home and personal projects as well. Whether you are already comfortable 
working in Visio and want to learn about new features, or are new to Visio, this book pro-
vides invaluable hands-on experience.

How this book is organized
This book is divided into 13 chapters that explore the rich set of Visio capabilities. In the 
first two chapters, you learn how to navigate within the Visio user interface, how to find di-
agram templates to help you get started, and how to create and work with diagrams. Each 
of the subsequent chapters introduces you to key concepts or diagram types and provides 
multiple examples. Depending on your experience with Visio, the exercises in each chapter 
either teach or reinforce important concepts because you are working with real diagrams 
and real-world examples.
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This book has been designed to lead you step by step through the tasks you’re most 
likely to want to perform with Visio 2013. If you start at the beginning and work your way 
through all of the exercises, you will gain enough proficiency to master the use of Visio. 
However, if you are only interested in certain topics or features, you can jump in anywhere 
to acquire exactly the skills you need.

Downloading the practice files
Before you can complete the exercises in this book, you need to download the book’s prac-
tice files to your computer. The practice files can be downloaded from the following page:

http://aka.ms/Visio2013SbS/files

IMPORTANT Visio 2013 is not available from this page. You should purchase and install that 
program before using this book.

The following table lists the practice files for this book.

Chapter File
Chapter 1: A visual orientation to a 
visual product

None

Chapter 2: Creating a new diagram Basic ShapesA_start.vsdx
Basic ShapesB_start.vsdx
Basic ShapesC_start.vsdx
Quick Draw_start.vsdx 
Size & Position_start.vsdx

Chapter 3: Adding sophistication to 
your drawings

Background Exercises_start.vsdx 
Corporate DiagramA_start.vsdx 
Corporate DiagramB_start.vsdx 
International Office.jpg
Orient Shapes and TextA_start.vsdx 
Orient Shapes and TextB_start.vsdx 
Shape Data_start.vsdx 
Starfish.jpg
Text ExercisesA_start.vsdx 
Text ExercisesB_start.vsdx
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Chapter File
Chapter 4: Creating flowcharts and 
organization charts

HR Recruiting Flowchart_start.vsdx 
Org Chart Data_start.xlsx
Photos folder

Chapter 5: Adding style, color, and 
themes

Align and Space_Start.vsdx
HR Recruiting FlowchartA_start.vsdx 
HR Recruiting FlowchartB_start.vsdx
Network diagram_start.vsdx

Chapter 6: Entering, linking to, and 
reporting on data

HR Process Data_start.xlsx
HR Process MapA_start.vsdx 
HR Process MapB_start.vsdx 
HR Process MapC_start.vsdx 
HR Process MapD_start.vsdx 
HR Process MapE_start.vsdx 
HR Process MapF_start.vsdx

Chapter 7: Adding and using 
hyperlinks

HR Process Map_start.vsdx 
Human Resources Policy Manual.docx
Sample PDF Document.pdf
Sample presentation.pptx
Sample Project file.mpp
Sample spreadsheet.xlsx

Chapter 8: Printing, reusing, and 
sharing diagrams

HR Process Map for Chapter08A_start.vsdx 
HR Process Map for Chapter08B_start.vsdx

Chapter 9: Creating network and data 
center diagrams

Network Diagram (Basic) with data_start.vsdx
Network Diagram (Basic)_start.vsdx
Network Diagram (Detailed)_start.vsdx
Network Diagram (Organized)_start.vsdx
Network Diagram with RackA_start.vsdx 
Network Diagram with RackB_start.vsdx

Chapter 10: Visualizing your data Casino Floor.vsdx
Contoso Network Data.xlsx
HR Recruiting Flowchart with data graphics_start.vsdx
HR Recruiting Flowchart_start.vsdx 
Network Diagram_start.vsdx
Sales Proposal Process TaskMap.pdf

Chapter 11: Adding structure to your 
diagrams

Containers, Lists and Callouts_start.vsdx
Data graphics legends_start.vsdx
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Chapter File
Chapter 12: Creating and validating 
process diagrams

HR Recruiting Flowchart Validation_start.vsdx
RuleSets -- BPMN 2.0.html
RuleSets -- Cross-Functional Flowchart.html
RuleSets -- Flowchart.html
RuleSets -- SharePoint 2010 Workflow.html
RuleSets -- SharePoint 2013 Workflow.html
Theater Ticketing ProcessA_start.vsdx
Theater Ticketing ProcessB_start.vsdx
Visio 2007 Flowchart_start.vsd

Chapter 13: Collaborating on and 
publishing diagrams

Collaboration Brainstorm DiagramA_start.vsdx
Collaboration Brainstorm DiagramB_start.vsdx
Theater Ticketing Process Status Data_start.xlsx
Theater Ticketing ProcessA_start.vsdx
Theater Ticketing ProcessB_start.vsdx
Timeline diagram_start.vsdx

Appendix: Looking under the hood Basic Shapes_start.vsdx
ShapeSheet_start.vsdx

Your companion ebook
With the ebook edition of this book, you can do the following:

 ▪ Search the full text

 ▪ Print

 ▪ Copy and paste

To download your ebook, please see the instruction page at the back of the book.
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Getting support and giving feedback
The following sections provide information about getting help with Office 2013 Professional 
or the contents of this book and contacting us to provide feedback or report errors.

Errata
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on our 
Microsoft Press site: 

http://aka.ms/Visio2013SbS/errata

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, email Microsoft Press Book Support at: 
mspinput@microsoft.com.

Please note that product support for Microsoft software is not offered through the previous 
addresses.

We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valuable 
asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in advance 
for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at: http://twitter.com/MicrosoftPress/.
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A visual orientation to a 
visual product

IN THIS CHAPTER, YOU WILL LEARN HOW TO

 ▪ Identify the editions and features of Visio 2013.

 ▪ Get started with Visio 2013.

 ▪ Explore, minimize, and restore the Visio ribbon.

 ▪ Understand tool tabs and add-in tabs.

 ▪ Understand shapes, masters, stencils, and templates.

 ▪ Explore the drawing window and manage the Shapes window.

 ▪ Pan and zoom in Visio.

Microsoft Visio is the premier application for creating business diagrams of all types, 
ranging from flowcharts, network diagrams, and organization charts, to floor plans and 
brainstorming diagrams. Even though this book contains dozens of examples and sample 
diagrams, it can only scratch the surface of the hundreds of types of diagrams you can cre-
ate with Visio.

Microsoft Visio 2013 continues the use of the fluent user interface (UI), otherwise known 
as the ribbon, that was introduced with Visio 2010. Regardless of what you might think of 
the ribbon in other Microsoft Office applications, it feels right at home in Visio, primarily 
because the goal of a ribbon-style interface is a visual presentation of a related group of 
functions, and Visio is, first and foremost, a visual product.

In this chapter, you will learn that there are three editions of Visio 2013, and will discover 
what’s new in the 2013 release of the product. You will launch Visio and explore the 
Backstage view and will then explore the tabs on the Visio ribbon. You will compare the 
permanent tabs on the ribbon with tool tabs sets and add-in tabs. You will learn about 
stencils, templates, masters, and shapes and how to manage the various windows that 
comprise the Visio user interface. Finally, you will learn how to pan and zoom the diagram 
in the drawing window.
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PRACTICE FILES You don’t need any practice files to complete the exercises in this chapter. 

Identifying the editions of Visio 2013
Visio 2013 is available in three editions. The first two editions utilize the traditional desktop 
software purchase and installation model and mirror the two editions that were offered in 
most prior Visio releases. The third edition is part of the Office 365 suite of subscription-
based applications.

 ▪ Visio Standard 2013 Visio Standard is the starter edition of Visio. It provides signifi-
cant capability for creating business diagrams and includes 26 templates for creating 
diagrams in six categories.

 ▪ Visio Professional 2013 Visio Professional expands on the Standard edition by 
offering more than four dozen additional templates for a total of 76 across eight 
categories. In addition, Visio Pro includes the ability to link diagrams to a wide variety 
of data sources, and includes a diagram validation capability that is especially well-
suited for the expanded set of business process diagrams it supports.

 ▪ Visio Pro for Office 365 This new edition of Visio 2013 provides the identical fea-
tures and templates as Visio Professional 2013. The key differences in this edition are 
in packaging and delivery, because it is part of Microsoft Office 365. Office 365 is a 
cloud-based subscription service. Instead of purchasing Visio Pro for Office 365, you 
pay a monthly subscription and can install the software on up to five computers run-
ning Windows 7 or Windows 8. Each time you install, you automatically receive the 
latest updates.

Identifying new features of Visio 2013
If you have used any previous version of Visio, you will find a rich set of new features de-
scribed in the sections that follow. Even if you’ve never used Visio, it will still be worth read-
ing through the features described here in order to learn more about the capabilities of the 
software.
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If you are upgrading from Visio 2010
Visio 2010 introduced the ribbon user interface and a long list of new features. Visio 2013 
continues the momentum with another long list of enhancements and new capabilities.

TIP The data-connected sample diagrams that were included with Visio 2010 and 
Visio 2007 are no longer included with Visio 2013. In addition, the database reverse 
engineering add-in is no longer packaged with Visio 2013.

 ▪ Updated, modern shapes Hundreds of shapes have been completely redesigned 
for Visio 2013 to make your diagrams look fresh and modern, and to accommodate 
Visio 2013 themes. The new shapes are included with the stencils used in many fam-
iliar templates, enhancing the appearance of Basic Network, Organization Chart, 
Timeline, Workflow, and SharePoint Workflow diagrams, among others.

 ▪ Professional appearance Visio 2013 themes have been dramatically enhanced, 
making it easier than ever to produce eye-catching yet professional-looking dia-
grams. In addition, themes have been supplemented with pre-designed visual 
variants that let you add your personal touch. Further, you can apply effects like 
reflection, glow, and bevel to provide additional emphasis.

 ▪ Integration with the cloud The Open, Save, and Save As pages in the Visio 2013 
Backstage view provide easy access to your SkyDrive account, as well as to Microsoft 
SharePoint and SharePoint Online sites.

 ▪ Improved integration with SharePoint Publishing Visio diagrams to SharePoint is 
easier than ever because SharePoint 2013 can open Visio files directly. Diagrams pub-
lished to SharePoint can be viewed using almost any web browser.

 ▪ Collaboration (commenting) Multiple people can read and add comments to 
a Visio diagram using either Visio or a web browser when diagrams are stored in 
SharePoint or SharePoint Online.

 ▪ Change shape With Visio 2013, you can replace one shape with another, and the 
new shape will retain the connections, text, and data from the original shape.

 ▪ Duplicate page You can create a duplicate copy of any Visio page with two clicks.

 ▪ Enhanced template and shape search It’s easier in Visio 2013 to locate the right 
template to begin a new diagram or to find exactly the right shape to enhance your 
diagram. Search results are sorted and filtered more effectively and duplicate results 
are eliminated.

1
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 ▪ Organization charts with photos The Organization Chart wizard has been en-
hanced in Visio 2013 to provide bulk import of photographs.

 ▪ Improved Mini Toolbar The Mini Toolbar that appears when you right-click either 
the drawing page or a shape has been revamped, further streamlining many actions 
and reducing mouse movement. The Drawing Tools, Connector Tool, Change Shape, 
Shape Styles, and alignment features have been added to the Mini Toolbar.

 ▪ Enhanced touch support Visio 2013 recognizes a greater array of gestures and 
touch for easier use on tablets and computers with touch screens.

 ▪ New file format All previous versions of Visio stored drawings in a proprietary file 
format. Visio 2013 joins other members of the Microsoft Office family in using the 
Open Packaging Convention, an XML-based format. The new .vsdx file format makes 
the contents of Visio drawings more accessible to other applications for a variety of 
purposes, including integration with SharePoint as described previously and following.

The following features are available only in the Professional edition of Visio 2013.

 ▪ Collaboration (coauthoring) Multiple authors can edit the same Visio 2013 
document simultaneously when the document is stored on SkyDrive, SharePoint, 
or SharePoint Online in Office 365. 

 ▪ SharePoint Workflow integration Visio 2013 supports the Microsoft .NET 
Framework 4 workflows that are supported in SharePoint 2013. In addition, 
Microsoft SharePoint Designer 2013 can open and manipulate Visio 2013 files 
directly. Consequently, you can use Visio’s visual workflow design features to 
create workflows in both Visio and SharePoint Designer, and then execute them 
with SharePoint Workflow.

 ▪ Updated BPMN and UML templates The Business Process Model and Notation 
(BPMN) template now conforms to version 2.0 of that standard, and the Unified 
Modeling Language (UML) templates conform to UML version 2.4.

SEE ALSO The Visio product team wrote a series of blog posts describing the new features 
in Visio 2013. Refer to blogs.office.com/b/visio/archive/2013/03/19/recapping-posts-on-the-
new-visio.aspx for a summary.

If you are upgrading from Visio 2007
Visio 2010 was the most significant upgrade to the capabilities of Visio in years. If you are 
upgrading from Visio 2007, you will benefit from the following features in addition to ev-
erything listed in the previous section.
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 ▪ New user interface Visio 2010 is the first version of the product to incorporate the 
ribbon user interface (UI) and the Backstage view. In addition, the Shapes window 
presents stencils more logically and can be minimized so it occupies less screen real 
estate.

 ▪ Enhanced user experience Live Preview is a tremendous addition to Visio 2010, 
because it enables you to view potential changes in color, fill pattern, font size, shape 
type, data graphics, and more, before you commit to the change. Visio 2010 also 
reduces required mouse movement with features like AutoConnect and Quick Shapes 
(refer to next bullet), and the Mini Toolbar.

 ▪ Diagramming support Multiple features whose names begin with Auto or Quick 
suggest that creating and organizing Visio 2010 diagrams is even easier, and it’s 
true. AutoConnect and Quick Shapes add new connectors and shapes; AutoAdd and 
AutoDelete simplify adding and removing shapes on the page; AutoSize expands and 
contracts Visio page dimensions. In addition, the Add page button creates new pages 
with a single click, and enhanced copy/paste enables you to control where shapes 
will be pasted. Finally, the enhanced Dynamic Grid provides excellent visual feedback 
when placing or moving shapes, dramatically reducing the need to nudge and reposi-
tion shapes after they are on the page.

 ▪ Structured diagrams Visio 2010 introduces a new type of shape called a container 
that provides more than just a visual grouping for a set of shapes. Shapes in a con-
tainer know they are contained, and the container knows the members that reside 
within it. Consequently, when you move, copy, or delete a container, all of the mem-
bers go with it. However, unlike a group shape, the member shapes are accessible 
with a single click just as if the container were not there.

In most containers, you can place member shapes wherever you’d like. However, a list 
is a special type of container that maintains members in ordered sequence. Each list 
member knows exactly where it resides within the list.

The third structured diagram element is a new type of callout. The purpose of a call-
out is still the same—to add annotations to shapes on the page—but both the call-
out and the target shape are aware of each other, which dramatically improves shape 
behavior.

Not only do containers, lists, and callouts enable users to make more effective dia-
grams more easily, they also provide significant opportunities to Visio developers for 
building location-aware shapes and for writing code that takes advantage of diagram 
structure.
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 ▪ Enhanced appearance Visio 2010 themes and effects add a new professional ap-
pearance to your diagrams. The themes gallery, with Live Preview, lets you sample 
more than two dozen coordinated sets of colors, fonts, patterns, and effects before 
choosing the one that is just right for your diagram.

 ▪ Improved CAD support Visio 2010 supports import, conversion, and export of 
newer file types from Autodesk’s AutoCAD software.

 ▪ Save as PDF or XPS The software to save diagrams in Portable Document Format 
(PDF) or XML Paper Specification (XPS) format is now bundled with Visio.

The following features are available only in the Professional or Premium editions of Visio 2010.

 ▪ Dynamic web diagrams Previous versions of Visio have allowed you to save a Visio 
drawing as a set of webpages but with one key limitation: if the diagram changed, 
you needed to republish the website. Visio 2010, in conjunction with Visio Services 
on SharePoint 2010, introduces the ability to create dynamic websites from data-
connected diagrams. Now, many changes to the diagram, or to the data behind the 
diagram, appear automatically for anyone viewing your diagram with a web browser.

 ▪ Business process Several new features add to your ability to create business process 
diagrams in Visio 2010: a BPMN template that conforms to the 1.2 version of the 
BPMN standard; a feature that automatically creates subprocess pages for flowcharts 
and BPMN diagrams; and a new interchange file type that lets you create SharePoint 
Workflow diagrams in Visio and export them to SharePoint Designer (you can also 
import SharePoint Workflow diagrams into Visio to view graphical representations of 
the workflows).

 ▪ Diagram validation You can ensure that your diagrams meet a minimum set of 
predefined conditions before you publish or distribute them using diagram valida-
tion rules. Four Visio 2010 templates—Basic Flowchart, Cross Functional Flowchart, 
Microsoft SharePoint Workflow, and BPMN—include predefined validation rule sets. 
You can edit the existing rule sets or create your own.

If you are upgrading from Visio 2003
Visio 2007 Professional introduced an important set of data-related enhancements that 
significantly improved your ability to create data-rich diagrams and to visualize that data 
creatively and effectively.

 ▪ Themes Visio 2007 introduces themes—a fast way to add style and a professionally 
designed look to your diagrams.
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 ▪ AutoConnect You no longer need to return to the stencil every time you want to 
add a shape to the page. When you click one of the four AutoConnect arrows that 
appear when you point to an existing shape on the drawing page, Visio adds a con-
nector and a copy of the currently selected master shape in the stencil.

 ▪ Save as PDF or XPS After downloading a free, add-in available from Microsoft, you 
can save Visio diagrams in either PDF or XPS format.

 ▪ Sample diagrams Visio 2007 includes five sample diagrams in the new Getting 
Started category on the startup screen. In the Professional edition, the diagrams 
are connected to data in Excel workbooks that are also included with Visio.

The following features are available only in the Professional edition of Visio 2007.

 ▪ Data linking A new linking wizard dramatically simplifies the task of linking shapes 
on the drawing page to data that resides in Microsoft Excel, Access, SQL Server, 
SharePoint lists, or almost any ODBC or OLEDB-compatible database. No program-
ming is required to establish connections or to refresh a diagram when the underlying 
data changes.

 ▪ Data graphics You can use Visio 2007 data graphics to visualize data by displaying 
text or a graphic that is based on the data inside the shape.

 ▪ PivotDiagrams You can build tree-structured data views using the new Pivot-
Diagram template.

 ▪ ITIL and Value Stream mapping New templates enable you to create two impor-
tant types of diagrams: Information Technology Infrastructure Library (ITIL) process 
maps and Value Stream maps.

Working with the ribbon
The Office ribbon is a dynamic user interface element; its appearance changes if the width 
of the window in which it is being viewed changes. As a result, a button might be large or 
small, it might or might not have a label, or it might even be an entry in a list.

For example, when sufficient horizontal space is available, the buttons on the Home tab are 
spread out, and the available commands in each group are visible.
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If you decrease the horizontal space available to the ribbon, small button labels disappear 
and groups of buttons might hide under one button that represents the entire group.

Compare the arrangement of buttons in the Font and Paragraph groups in the preceding 
and following graphics, for example. Also, in the following graphic, notice that the captions 
for the rightmost buttons in the Arrange group have disappeared, and that the Arrange 
group has been collapsed to a single button. Collapsed buttons and groups retain all of 
their functions, as the submenu beneath the Arrange button demonstrates.

When the ribbon becomes too narrow to display all of the groups, a scroll arrow appears at 
its right end. Clicking the scroll arrow displays additional groups.

The width of the ribbon depends on three factors:

 ▪ Program window width Maximizing the program window provides the most space 
for the ribbon. To maximize the window, click the Maximize button, drag the borders 
of a nonmaximized window, or drag the window to the top of the screen.

10    Chapter 1  A visual orientation to a visual product



 ▪ Screen resolution Screen resolution is the size of your screen display expressed as 
pixels wide × pixels high. Your screen resolution options are dependent on the display 
adapter installed in your computer, and on your monitor. Common screen resolutions 
range from 800 × 600 to 2560 × 1600. The greater the number of pixels wide (the 
first number), the greater the number of buttons that can be shown on the ribbon. 

To change your screen resolution:

a. Display the Screen Resolution control panel item in one of the following ways:

 ▪ Right-click the Windows desktop, and then click Screen Resolution.

 ▪ Type screen resolution in Windows 8 Search, and then click Adjust screen reso-
lution in the Settings results.

 ▪ Open the Display control panel item, and then click Adjust resolution.

b. On the Screen Resolution page, click the Resolution arrow, click or drag to select 
the screen resolution you want, and then click Apply or OK.
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 ▪ The magnification of your screen display If you change the screen magnification 
setting in Windows, text and user interface elements are larger and therefore more 
legible, but fewer elements fit on the screen. You can set the magnification from 100 
to 500 percent.

You can change the screen magnification from the Display page of the Appearance 
and Personalization control panel item. You can display the Display page directly 
from Control Panel or by using one of the following methods:

 ▪ Right-click the Windows desktop, click Personalize, and then in the lower-left 
corner of the Personalization window, click Display.

 ▪ Type display in Windows 8 Search, and then click Display in the Settings results.

To change the screen magnification to 125 or 150 percent, click that option on the 
Display page. To select another magnification, click the Custom sizing options link 
and then, in the Custom sizing options dialog box, click the magnification you want 
in the drop-down list or drag the ruler to change the magnification even more.
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After you click OK in the Custom sizing options dialog box, the custom magnification 
is shown on the Display page along with any warnings about possible problems with 
selecting that magnification. Click Apply on the Display page to apply the selected 
magnification.

Adapting exercise steps
The Visio ribbon consists of multiple tabs, each of which contains a set of related 
functions. The function buttons on any one tab are organized into named groups. 
Consequently, the instructions in the book that guide you to a specific function or 
button will include three parts. For example:

On the Home tab, in the Tools group, click the Pointer Tool button.

The screen shots shown in this book were captured at a screen resolution of 1024 × 
768, at 100% magnification. If your settings are different, the ribbon on your screen 
might not look the same as the one shown in this book, but you can easily adapt the 
steps to locate the command. 

For example, if a button appears differently on your screen than it does in this book, 
start by clicking the specified tab, and then locate the specified group. If a group has 
been collapsed into a group list or under a group button, click the list or button to 
display the group’s commands. If you can’t immediately identify the button you want, 
point to likely candidates to display their names in ScreenTips.

Instructions in this book are based on traditional keyboard and mouse input methods. 
If you’re using Visio on a touch-enabled device, you might be taking action by tap-
ping with your finger or with a stylus. If so, substitute a tapping action any time you’re 
instructed to click a user interface element. Also note that when you’re instructed to 
type information in Visio, you can do so by typing on a keyboard, tapping in the entry 
field under discussion to display and use the onscreen keyboard, or even speaking 
aloud, depending on your computer setup and your personal preferences.

Getting started with Visio 2013
When you start Visio 2013, it presents a startup page that is new to this version of Visio and 
is common to both the Standard and Professional editions of Visio 2013.
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Key sections of the start page are described in the following list.

 ▪ In the narrower left column is a list of recently opened diagrams. Clicking any dia-
gram name opens it again.

If you want to open a diagram that is not on the Recent list, click the Open Other 
Drawings button at the bottom of the list and Visio will take you to the Open page 
that is described in the next section.

 ▪ In the wider right column is a collection of thumbnails representing recently used or 
recommended templates.

 ▪ Above the template thumbnails are four important ways to find Visio templates.

 ▪ You can type any words into the Search for online templates box and Visio will 
present templates that match your keywords.

 ▪ You can click any word in the Suggested searches list to initiate an online search 
for matching templates.

14    Chapter 1  A visual orientation to a visual product



 ▪ Featured is the default selection for the template thumbnails that appear in the 
main part of the page (refer to the preceding graphic). The presentation of thumb-
nails is dynamic; the templates you use most frequently will rise to the top.

 ▪ Clicking Categories presents a set of template categories that are the same as 
the categories in previous versions of Visio: Business, Flowchart, General, Maps 
and Floor Plans, Network, and Schedule. The Professional edition also includes 
Engineering, and Software and Database categories.

At the end of the template categories list is an additional entry called New from ex-
isting. Clicking this thumbnail enables you to select any existing Visio diagram. Visio 
will then open a copy of the diagram as a new document and will leave the original 
untouched.

IMPORTANT Clicking a suggested search term will not produce the same result as 
selecting a template category of the same name. For example, clicking the Flowchart 
search term will yield some of the same templates that you will find in the template 
category named Flowchart, however, it will also return several—or several hundred—
additional templates, both for Visio and for other programs in the Office suite. 
 
If you would like to locate Visio 2013 templates using a method that is most like what 
you are familiar with from a previous version of Visio, click Categories and then select 
the desired template category.

SEE ALSO Microsoft has published a series of quick-start guides for the programs in 
the Office family at office.microsoft.com/en-us/support/office-2013-quick-start-guides-
HA103673669.aspx.

Exploring the Backstage view
The Backstage view is the central location for managing files and setting the options that 
control how Visio 2013 operates. You access the Backstage view by clicking the File tab at 
the top left of the Visio window. 

Of the 11 pages in the Backstage view, only four—New, Open, Account, and Options—are 
available if you do not have a diagram open. The remaining seven appear when you open a 
diagram.

TIP If you are in the Backstage view and have a diagram open, you can return to the 
diagram by clicking the left-pointing arrow in the upper-left corner of the Visio window. 
If you don’t have a diagram open, clicking the arrow will return you to the start screen.

The pages in the Backstage view are described in the following sections.
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Info
When you have a diagram open and click the File tab, Visio presents the Info page.

The center section of the page includes four command buttons.

 ▪ You will learn more about the Remove Personal Information button in Chapter 8, 
“Printing, reusing, and sharing diagrams.”

 ▪ You can click the Reduce File Size button if document size is a major consideration.

 ▪ The Check Compatibility button checks the current diagram for features that are not 
compatible with previous versions of Visio.

 ▪ You will learn about the SharePoint publishing settings behind the Set Publish 
Options and Check Data Connections button in Chapter 13, “Collaborating on 
and publishing diagrams.”

The right side of the page provides information about the open document, along with a 
Properties list that you can use to view and set additional document properties. You will 
use the Properties list in several places in this book, including Chapter 7, “Adding and using 
hyperlinks,” and Chapter 8.
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SEE ALSO If you open a file from a previous version of Visio, it will open in compatibility 
mode, and an additional button, labeled Convert, will appear at the top of the Info page. 
Refer to “The Visio 2013 file formats” in the Appendix for more information about working 
with files from previous versions of Visio.

New
The New page provides access to both built-in templates and online templates. You access 
built-in templates by clicking a diagram thumbnail in the lower part of the page. You can 
either type your own search terms or use the predefined search terms at the top of the 
page to locate templates from Office.com.

The preceding graphic displays Featured diagrams, while the following graphic shows the 
template Categories for Visio Standard. Be sure to read about the difference between 
featured templates and template categories at the beginning of the “Getting started with 
Visio 2013” section.

1

 Getting started with Visio 2013    17



Clicking any template category displays thumbnails for the diagrams in that category.
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If you click once on a diagram thumbnail, Visio displays information about that template, as 
shown in the following graphic. If you double-click a diagram thumbnail, Visio launches a 
new diagram.

TIP When you create a new diagram, Visio names it Drawingn, where n is a sequence num-
ber that is incremented for each new drawing created within one Visio session. Closing and 
restarting Visio always resets the sequence number to 1.

Visio templates are provided in two different sets of measurement units. 

 ▪ Metric Metric drawings are sized using International Standards Organization (ISO) 
specified paper sizes; the default size is usually A4. Metric templates also include 
other ISO drawing and paper sizes. All measurements are in millimeters or other met-
ric measurement units.

 ▪ US Units Diagrams created with US Units use the 8.5-by-11-inch, letter-sized paper 
that is common in the United States and parts of Canada and Mexico. Templates cre-
ated for US Units also include additional drawing and paper sizes that are common in 
those countries. The default measurement units are inches and feet.

Depending on your system configuration, you might be offered a choice between the two, 
as shown in the preceding graphic.
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Open
The Open page provides access to previously stored Visio diagrams. 

TIP If you are familiar with the Backstage view in Visio 2010, you will notice that there is 
no longer a separate Recent page in the Visio 2013 Backstage view; Recent drawings are 
available on the Open page instead.

One of the first things you’ll notice on the Visio 2013 Open page is that the buttons in the 
center column make it just as easy to access diagrams stored on SharePoint or SkyDrive as it 
is to open documents on your computer. Simply click any of the location buttons in the cen-
ter column to display a list of recently used folders along with a Browse button for that lo-
cation. The page that results from clicking the button for the Visio Step By Step SharePoint 
Online site is shown in the following graphic. 
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Click Add A Place to pin additional SkyDrive or SharePoint Online locations to the 
Open page.

When you click the Browse button on the Open page, Visio displays the Windows Open 
dialog box. The file type filter in the Open dialog is preset to display Visio drawings, tem-
plates, and stencils that were created in the new Visio 2013 file format, as well as those 
created with previous versions of Visio.

SEE ALSO To learn more about the new Visio file formats and about opening and con-
verting files created in previous versions of Visio, refer to “The Visio 2013 file formats” 
in the Appendix.

Save
Clicking Save for a previously unsaved diagram displays the Save As page shown in the fol-
lowing section. Clicking Save for a previously saved diagram simply saves the changes.

Save As
On the Save As page, you can choose a local or remote location and then either select a 
recent folder or use the Browse button to navigate to the desired location.
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Print
The Print page provides a print preview and printing options. You will learn about print 
options in Chapter 8.
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Share
The Share page offers two techniques for sharing your Visio drawing. 

You can click Invite People to publicize your diagram via email or social media. The first step 
is to click the Save To Cloud button to store your diagram to either SkyDrive or SharePoint. 
After the save operation completes, Visio provides an email form and several buttons you 
can use to share links to your diagram.

You can click the Email button to share your diagram using any of the options listed on the 
right side of the following graphic.
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Export
The Export page enables you to create a PDF or XPS document as well as to save in a 
wide variety of other file formats. You will learn about exporting to other file formats in 
Chapter 8, “Printing, reusing, and sharing diagrams,” and Chapter 12, “Creating and validat-
ing process diagrams.”
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Close
There is no Close page—clicking Close simply closes the active diagram.

Account
The Account page summarizes information about the Microsoft Account (formerly known 
as Live ID) that you have linked to Visio. Links in the Account column enable you to change 
your Microsoft Account details and to switch to another Microsoft Account if you have 
more than one. The same column provides drop-down lists you can use to alter the Office 
Background and Office Theme used for Visio and all other Office applications.

Clicking the About Visio button in the right-hand column displays version information and 
your product ID. The upper portion of the About Microsoft Visio dialog box is shown in the 
following graphic. 

TIP The About Microsoft Visio dialog box does not indicate whether you are running the 
Standard or Professional edition of Visio. However, that information is displayed in the title 
bar of the Visio window as shown in the preceding graphic.
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Options
The Options button opens a dialog box that contains dozens of settings you can use to cus-
tomize the operation of Visio. Many people use Visio 2013 without ever needing to change 
any of these options, but it’s a good idea to examine the option categories for potential 
future use.

 ▪ General Type your user name and initials as well as set various global options, 
including Live Preview and the Visio window color scheme.

 ▪ Proofing Set autocorrect, spelling, and grammar options.

 ▪ Save Set the default Visio save format (Visio Document; Visio Macro-Enabled 
Document; Visio 2003-2010 Document) and the document management check 
out/check in options.

 ▪ Language Set editing, display, help, and ScreenTip language parameters.
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 ▪ Advanced Set dozens of options in five categories: Editing, Display, Save/Open, 
Shape Search, and General.

 ▪ Customize Ribbon Add/rearrange commands on built-in ribbon tabs; create new 
tabs and commands.

 ▪ Quick Access Toolbar Add/remove command buttons on the Quick Access Toolbar.

 ▪ Add-ins View and add/delete Visio add-ins.

 ▪ Trust Center View and edit macro settings and other trust-related options.

Exploring the Visio ribbon
Earlier in this chapter, the graphics in “Working with the ribbon” demonstrated how the 
appearance of the ribbon can change depending on the width of the Visio window.

In this exercise, the width of the ribbon will remain constant at 1024 pixels and you will 
explore each of the Visio tabs.

IMPORTANT Most of the screen shots in this book feature the Professional edition ribbon. 
Consequently, there might be tabs, buttons, or options in the screen shots that don’t apply if 
you are using the Standard edition. In general, you can ignore any buttons or tabs that do not 
appear on your computer screen. Where necessary, the text will distinguish those exercises or 
functions that can only be performed with a specific Visio 2013 edition.

 SET UP If Visio is already running, click File, and then click New. If Visio is not running, 
start it. On either the New or startup page, double-click the Basic Diagram thumbnail.

1 Click the Home tab if it is not already selected.

The Home tab is just what it sounds like: a place where you will spend a consider-
able amount of time. The Home tab contains the largest number of buttons by far, 
because the Visio team at Microsoft tried to fit as many of the most frequently used 
functions as possible onto this tab. You’ll find sets of related buttons organized into 
groups called Clipboard, Font, Paragraph, Tools, Shape Styles, Arrange, and Editing.

You will use buttons on this tab in most of the exercises in this book.

1

 Exploring the Visio ribbon    27



TIP Many of the groups on the Visio tabs include a small arrow in the lower-right 
corner of the group (refer to the Font, Paragraph, and Shape Styles groups above). 
The arrow button, known as the dialog box launcher, opens a dialog box that provides 
detailed control over multiple functions related to that group. In many cases, the 
dialog box that opens will look familiar to experienced Visio users, because it is the 
same one that was used in previous Visio versions.

2 Click the Insert tab to access the Pages, Illustrations, Diagram Parts, Links, and Text 
groups. Many of the functions available on this tab mirror the items on the Insert 
menu in Visio 2007 and earlier.

You will use buttons on this tab in multiple chapters including Chapter 3, “Adding so-
phistication to your drawings,” and Chapter 11, “Adding structure to your diagrams.”

TIP Ribbon buttons that display a downward-pointing arrow behave in one of two 
ways. When you point to some buttons, like the Container button on the left in the 
following graphic, the entire button is illuminated. Clicking this type of button always 
presents a set of options related to the button title. 
 
When you point to other buttons, like the Text Box button in the following graphic 
on the right, only half of the button is illuminated. Clicking the half without the arrow 
performs the default action for the button. Clicking the half with the arrow presents a 
menu of options.

3 Click the Design tab to change Page Setup, select Themes or Variants, create or edit 
page Backgrounds, and change page Layout.

You will use buttons on this tab in various exercises, including those in Chapter 3, “Adding 
sophistication to your drawings,” and Chapter 5, “Adding style, color, and themes.”
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4 Click the Data tab.

IMPORTANT This tab is available only in the Professional edition.

On the Data tab, you can establish and maintain links to External Data, Display 
Data using data graphics, and Show/Hide both the Shape Data and External Data 
windows.

You will use buttons on this tab primarily in Chapter 6, “Entering, linking, and report-
ing on data,” and Chapter 10, “Visualizing your data.”

5 Click the Process tab.

IMPORTANT This tab is available only in the Professional edition.

In the Subprocess group, you can create a new subprocess or link to an existing one. 
In the Diagram Validation group, you can validate a drawing against a set of busi-
ness rules and manage validation issues. You can also import or export a SharePoint 
Workflow from this tab.

You will use buttons on this tab in Chapters 12 and 13.

6 Click the Review tab for access to functions for Proofing, Language, Comments, and 
Reports.

You will use buttons on this tab in various exercises, including those in Chapters 3 
and 6.
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7 Click the View tab.

As the name suggests, most of the buttons on this tab affect which Visio features are 
visible on the screen:

 ▪ The lone button in the Views group sets Visio into full-screen display mode. 

KEYBOARD SHORTCUT Press F5 to enter or exit full-screen view mode.

 ▪ The Show group controls which drawing aids and task panes are visible.

 ▪ Use the Zoom buttons to change the magnification level in the drawing window.

 ▪ The Visual Aids group enables and disables various on-screen drawings aids.

 ▪ Use the Window buttons to arrange or select among multiple windows when you 
have more than one drawing open.

 ▪ The Macros group provides access to the Visio macro programming window and 
to a list of pre-programmed add-ons that enhance the capabilities of Visio.

You will use buttons on this tab in exercises later in this chapter and throughout the 
rest of the book.

+  CLEAN UP Close the Drawing1 drawing. It is not necessary to save your changes.

TIP The buttons and controls on all ribbon tabs display pop-up tooltip text when you point 
to them. If you are unsure of the function of any button, just point to the button to view the 
tooltip.

SEE ALSO If you are familiar with versions of Visio prior to Visio 2010 and would like help 
shifting from toolbars and menus to the ribbon, Microsoft has created an interactive guide 
to the ribbon for each product in the Office suite. When you click a toolbar or menu item 
in the guide, it will display the appropriate ribbon button. You can find the Visio guide at 
office.microsoft.com/en-us/visio-help/learn-where-menu-and-toolbar-commands-are-in-
office-2010-and-related-products-HA101794130.aspx. Although this guide was created 
for Visio 2010, the Visio 2013 ribbon is sufficiently similar that you will still find the guide 
to be helpful.
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Where are the keyboard shortcuts?
If you are accustomed to using keyboard shortcuts, you’ll be happy to know that they 
still exist in Visio 2013. Most shortcuts are the same as in previous versions of Visio, 
although some were changed to make them consistent with other applications in the 
Office suite.

The keyboard shortcut letters appear when you press the Alt key. The following 
graphic shows the shortcut letter associated with each tab on the Visio 2013 ribbon. 
Notice, too, that each button on the Quick Access Toolbar has been assigned a short-
cut number based on its position within the Quick Access Toolbar.

Pressing the letter or number for any displayed shortcut key opens the relevant tab 
and displays the shortcut keys for that tab. For example, pressing the N key when in 
the view shown in the previous graphic displays the Insert tab and the shortcut letters 
shown in the following graphic.

TIP Previous versions of Visio used the capital letter I as the shortcut key for the Insert 
menu. Visio 2013 uses the keyboard shortcut N to be consistent with other Office 
applications.
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Understanding tool tabs and add-in tabs
All of the ribbon tabs shown in the preceding sections are visible 100 percent of the time as 
you run Visio. However, there are two types of tabs that only appear when necessary. 

A Tool tab set only appears in a particular drawing context, usually when a specific type of 
shape is selected on the drawing page. Tool tab sets usually appear to the right of the View 
tab and are not activated automatically, that is, you must click the tab to view its contents. 
A tool tab set includes a colored header and may contain one or more tool tabs under the 
header. Here are examples of two tool tab sets:

 ▪ Picture Tools This tool tab set appears whenever you insert or select a graphic on a 
Visio drawing page. The green Picture Tools header contains a Format tool tab, which 
includes buttons to crop, rotate, and otherwise modify a picture.

 ▪ Container Tools This tool tab set appears whenever you insert or select a Visio con-
tainer. The orange Container Tools header contains a Format tool tab, which includes 
buttons to size and style containers, and to control container membership. You will 
learn about containers in Chapter 11.

32    Chapter 1  A visual orientation to a visual product



Add-in tabs are associated with software that adds capabilities to Visio. Some add-ins are 
packaged with Visio by Microsoft; others are sold by third-party software vendors.

Unlike tool tabs, add-in tabs look and behave exactly like permanent Visio tabs with one 
primary exception: they appear when an add-in application is active and disappear when it 
is not. Here are two examples:

 ▪ Org Chart This add-in is included with Visio and is activated whenever you create 
or edit a drawing that uses either of the Visio organization chart templates. You will 
learn about organization charts in Chapter 4.

 ▪ TaskMap This third-party add-in provides easy-to-use process mapping, analysis, 
and improvement functions that can be used with any edition of Visio.

SEE ALSO For more information about the TaskMap add-in, go to www.taskmap.com.
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Minimizing and restoring the Visio ribbon
Because the ribbon takes a reasonable amount of space at the top of the Visio window, you 
may want to minimize it if you need more space for the drawing page. The key to doing so 
is a very small up arrow located in the lower-right corner of the ribbon. 

Clicking this button minimizes the ribbon as shown in the following graphic. To temporarily 
display a tab when it’s minimized, click the tab name.

To restore the ribbon to normal operation after it has been minimized, click the pushpin 
located in the lower-right corner of the ribbon.
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Understanding shapes, masters, stencils, 
and templates

Before you explore the rest of Visio, it’s helpful to understand a number of commonly used 
terms:

 ▪ Master An object in a Visio stencil. The vast majority of people who create diagrams 
with Visio use the masters that ship with Visio or that they download from the Inter-
net. You can create new masters; however, the techniques for doing so are outside the 
scope of this book.

 ▪ Stencil A collection of masters. 

 ▪ Shape An object on a Visio drawing page. Often you create shapes by dragging a 
master from a stencil to the drawing page; however, you can also create shapes in 
other ways. (You will learn more about shapes in Chapter 2, “Creating a new diagram,” 
and throughout this book.) 

A shape can be very simple: a line, a polygon, an image. A shape can also be a so-
phisticated object that changes appearance or behavior as data values change, as its 
position on the page changes, or as properties of another shape change—the pos-
sibilities are endless. 

 ▪ Template A Visio document that includes one or more drawing pages with preset di-
mensions and measurement units. A template may also include one or more stencils; 
it may include background pages and designs; its pages may contain shapes or text. A 
template may also include special software that only operates in that template.

 ▪ Workspace A collection of Visio windows and window settings. At minimum, the 
workspace consists of the drawing window and the zoom settings for the pages in 
the drawing; frequently, it also includes a Shapes window containing one or more 
stencils. The workspace can also include the Shape Data, Size & Position, or Pan & 
Zoom windows. Unless you have changed the default action, Visio saves the on-screen 
workspace whenever you save the document. As a result, when you next open the 
same document, the same collection of windows is restored.

TIP Despite the distinction made in this list between a master and a shape, you will find 
that many people refer to an object in a stencil as a shape. Indeed, when you think about 
it, the window that displays stencils is called the Shapes window! Consequently, unless the 
distinction is important in a specific context, the text in this book will refer to shapes in a 
stencil and to shapes on the drawing page.
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Exploring the drawing window
When you start Visio, two windows normally appear below the ribbon.

 ▪ The Shapes window on the left contains one or more stencils, each represented by 
a header bar containing the name of the stencil. Depending on the number of open 
stencils in the Shapes window, a scroll bar might appear at the right of the headers. 
You will investigate the Shapes window in the next section of this chapter.

TIP The width of the Shapes window is adjustable, so the one on your system may be 
wider or narrower than the one that appears in the preceding graphic.
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 ▪ The larger window on the right is called the drawing window because it contains the 
drawing page. The drawing window is bounded on the top and left by rulers that 
display inches, millimeters, or whatever units you have selected (or your template has 
selected) for measuring page dimensions.

TIP All previous versions of Visio displayed the grid on the drawing page by default. 
However, in Visio 2013, the opposite is true. To make the grid visible, click Grid in the 
Show group on the View tab.

At the lower left of the drawing window is a set of page controls.

 ▪ A Page name tabs display the name of each page and the active page name is dis-
played in a different color. Click any tab to change to that page. Right-click any page 
name tab to access page management functions including the new Duplicate Page 
function.

 ▪ B Click the All button to display a list of all pages in the diagram. The name of the 
active page is highlighted in the list.

 ▪ C Click the Insert Page button to add a new page.

Below the Shapes and drawing windows is a status bar that contains a variety of indica-
tors, buttons, and controls. The buttons and indicators on the left end of the status bar are 
context sensitive, so they will show different information depending on the state of the 
drawing.
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If nothing is selected on the drawing page, the left end of the status bar looks like the fol-
lowing graphic.

 ▪ A The Page Number button shows which page is active and displays the total num-
ber of pages in the current drawing; click this button to open the Page dialog box.

 ▪ B The Language area displays the language of the current drawing; the drawing lan-
guage is normally derived from Windows or Visio language settings.

 ▪ C Click the Macros button to start the macro recorder.

If you have selected a shape on the drawing page, the left end of the status bar looks like 
the following graphic instead.

 ▪ A Same as previous A.

 ▪ B Same as previous B.

 ▪ C Same as previous C.

 ▪ D This area contains three buttons. The Width and Height buttons display the di-
mensions of the selected shape and the Angle button displays its angle of rotation; 
click any of the three buttons to open the Size & Position window.

The right end of the status bar contains a variety of useful buttons and controls.

 ▪ A Click the Presentation Mode button to view the active diagram in full-screen pre-
sentation mode.

 ▪ B Move the Zoom slider to zoom in or out.

 ▪ C The Zoom Level button displays the current zoom percentage; click it to open the 
Zoom dialog box.

38    Chapter 1  A visual orientation to a visual product



 ▪ D Click the Fit Page To Current Window button to resize the drawing page so the 
entire page is visible in the drawing window.

 ▪ E Click the Switch Windows button to switch to another Visio window.

TIP Most other Office applications require the use of a button on the View tab of the 
ribbon to switch among multiple open windows. The Visio development team had 
the foresight to include the Switch Windows button (E) on the status bar where it is 
much more convenient.

If you right-click anywhere in the status bar, the Customize Status Bar menu appears. You 
can click any of the options in the Customize Status Bar menu to toggle the display of a 
button or control.

Managing the Shapes window
The upper part of the Shapes window contains a list of stencil titles and the lower part dis-
plays the shapes from the currently selected stencil.

In this exercise, you will learn various ways to manipulate the Shapes window so it appears 
in the most useful size and position when you are working on a drawing.
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 SET UP If Visio is already running, click File, and then click New. If Visio is not running, 
start it. On either the New or startup page, click Categories, click Maps and Floor Plans, 
and then double-click the Office Layout thumbnail. Save the new drawing as Exploring 
Visio 2013.

IMPORTANT One of the user interface changes in Visio 2013 is that window boundaries have 
been designed to fade into the background so they don’t interfere visually with the content of 
the drawing. Consequently, the appearance of some parts of the Shapes window is less obvious 
than in previous versions of Visio. In particular, the boundary of the Shapes window is not 
visible. The only way to know where it is located is to move the pointer slowly across it until the 
pointer changes to a window resize tool.

1 Change the width of the Shapes window by dragging the window boundary left or  
right. The pointer changes to a double-headed arrow as the window border is dragged 
to a wider or narrower view. (In the following graphic, the pointer is located to the 
right of the Search tab.)
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2 Minimize the Shapes window by clicking the Minimize the Shapes window arrow 
shown in the preceding graphic. Even though the descriptions are now hidden, all of 
the masters in the stencil are still accessible when the Shapes window is minimized. 
Consequently, this view is useful when you need more space for the drawing window 
and the icons depicting the masters in the stencil are very recognizable.

3 Return the Shapes window to its former size by clicking the Expand the Shapes 
window arrow highlighted in the preceding graphic.

4 To hide the Shapes window entirely, on the View tab, in the Show group, click the 
Task Panes button, and then click Shapes.

TIP The various subwindows that can be opened or closed within the Visio window 
are sometimes referred to as task panes.
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TIP The Shapes window can be reopened by clicking the same button you used to 
close it.

5 On the View tab, in the Show group, click Task Panes, and then click Shapes. If the 
window does not already show two columns of shapes, adjust the width so it does. 
The Walls, Doors and Windows title bar is highlighted, indicating that this is the ac-
tive stencil. However, the Office Layout template includes several additional stencils.

6 In the Shapes window, click Office Furniture.

TIP When you click the title bar of any stencil, the title bars remain stationary, and 
the stencil always opens in the same place, below all title bars. This is a significant 
improvement in behavior over versions of Visio prior to Visio 2010.

You are not restricted to using just the stencils that open in a particular template, as 
you will discover in the following steps.
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IMPORTANT If there is a sufficient number of masters in a stencil to require scroll bars, 
the scroll bars are only visible if the pointer is inside the stencil portion of the Shapes 
window. The downside of this visual technique is that you don’t necessarily know there 
are more shapes available (refer to the following graphic on the leftw) unless you move 
the pointer into the stencil portion of the Shapes window (following graphic on the right).

7 In the Shapes window, click More Shapes, and then point to General. (Do not click any 
stencils in the General group yet.) A fly-out menu containing stencil names appears. In 
the following graphic, the collection of stencils in the General group is visible.
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8 With the cascading menus open from step 7, click Basic Shapes. Visio opens the 
Basic Shapes stencil. In a behavior change from Visio 2010, a check mark appears to 
the left of the stencil you selected, but the fly-out menus remain open, allowing you 
to select additional stencils from the same or another stencil family.

9 Click anywhere in the Visio window to close the cascading menus.

Although it isn’t actually necessary in this exercise, it’s helpful to know how to close 
stencils you no longer need, so that’s what you will do in the remaining step.

10 Right-click Basic Shapes, and then click Close.

TIP Although you didn’t use it in this exercise, be sure to notice the Search tab at the 
top of the Shapes window. The enhanced shape search function in Visio 2013 yields 
more targeted results with fewer duplicate results.

+  CLEAN UP Leave the Exploring Visio 2013 drawing open if you are continuing with 
the next exercise. If not, there is no need to save changes.
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Panning and zooming in Visio
As you work with more detailed Visio diagrams, you will find that you frequently need to 
zoom in and out and pan—move left-right and up-down—within the drawing window. 
Both can be accomplished using a variety of techniques, some of which rely on your mouse, 
some that use a special Pan & Zoom window, and others that use keyboard shortcuts.

In this exercise, you will learn several techniques to pan and zoom your diagram, beginning 
with keyboard shortcuts and ending with the Pan & Zoom window.

 SET UP If the Exploring Visio 2013 drawing is still open from the preceding exercise, 
continue with this exercise. Otherwise, create a new drawing: on the File tab, click New, 
click Categories, click Maps and Floor Plans, and then double-click the Office Layout 
thumbnail. Save the new drawing as Exploring Visio 2013.

1 Click Office Furniture if it is not already the active stencil, and then drag a Round 
table shape onto the drawing page.

2 Drag a Chair shape onto a different part of the page.

3 Drag a Corner table shape onto yet another part of the page.

4 Drag a Stool and a Square table onto the page. Space the shapes so they occupy at 
least half of the drawing page. 

Your diagram might look something like the following graphic.
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5 Hold down the Ctrl+Shift keys (the cursor will change to a magnifying glass with a 
plus sign), and then drag a rectangle around two of the shapes on the drawing page.

IMPORTANT You must press Ctrl+Shift before you click for this zoom technique to 
work.
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6 Release the mouse button and the keyboard keys. Visio sets the view in the drawing 
window to just the rectangle you outlined with the mouse.

7 Press Ctrl+Shift+W to return to a view of the whole drawing page.

TIP Ctrl+Shift+W is an incredibly useful keyboard shortcut to remember because you 
will frequently zoom in to part of a drawing and then want to return to full page view. 
To help remember this shortcut, just remember that W is the first letter of whole page.

IMPORTANT In Visio 2007 and earlier, the keyboard shortcut to view the whole page 
was Ctrl+W. If you’ve upgraded from one of those versions of the software, it may take 
a bit of retraining to get accustomed to using Ctrl+Shift+W instead. To make matters 
worse, in Visio 2013, Ctrl+W closes the active document. (You will receive a warning if 
the document has unsaved changes.)
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8 Hold down the Ctrl key and rotate the mouse wheel. Visio zooms in or out as you 
rotate the mouse wheel.

IMPORTANT You can only perform this step if your mouse has a wheel.

TIP Sometimes you may want to zoom in on a specific shape. Visio provides an option 
setting that makes this very easy to do. On the File tab, click Options, and then click 
Advanced. In the Editing Options section of the Visio Options dialog box, click Center 
Selection On Zoom. Now when you select a shape and press the Ctrl key while rotating 
the mouse wheel, Visio automatically zooms in and out on the selected shape.

9 Press Ctrl+Shift+W to return to a view of the whole drawing page.

10 On the View tab, in the Show group, click the Task Panes button, and then click Pan 
& Zoom. The Pan & Zoom window opens. You can drag it to position it wherever 
you’d like.

TIP You can also open the Pan & Zoom window by clicking the Pan & Zoom button 
on the right end of the status bar. (Refer to “Exploring the drawing window” earlier in 
this chapter for information about the Visio status bar.)
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11 Click in the Pan & Zoom window, and then drag the cursor to create a rectangle that 
surrounds any two of the shapes. A blue rectangle appears in the Pan & Zoom win-
dow and the drawing window shows only the selected portion of the page.
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12 In the Pan & Zoom window, click in the interior of the blue rectangle, and then drag 
into another part of the miniature drawing page. The drawing window now shows the 
newly selected area of the drawing page.

With the Pan & Zoom window open, you can:

 ▪ Continue to move the blue rectangle to reposition what appears in the drawing 
window.

 ▪ Drag the edges or the corners of the blue rectangle to resize it and change the 
zoom level.

 ▪ Drag the slider control on the right edge of the Pan & Zoom window to change 
the zoom level.

For many drawings, the Pan & Zoom window isn’t necessary and may even be in the 
way. However, it is extremely helpful when your drawing page is very large, as it may 
be if you are working on diagrams such as engineering drawings, floor plans, or 
office layouts.

+  CLEAN UP Close the Pan & Zoom window. Save changes and close the drawing.
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TIP If you have a mouse with a wheel button, you can move the drawing page up and 
down in the drawing window by rotating the mouse wheel. You can reposition the drawing 
page to the left and right by holding down the Shift key while rotating the mouse wheel.

You can also move the drawing page using the arrow keys on your keyboard. Be sure that 
no shapes are selected before pressing the arrow keys, however, or you will move the se-
lected shape(s) instead of moving the page.

Key points
 ▪ Visio Professional contains templates, stencils, ribbon tabs, and functions that are not 

included in Visio Standard. A key focus for the additional features in Visio Professional 
is linking to data sources and then visualizing that data using text callouts and icons. 
Professional features also enhance diagram collaboration, and enable documenting 
and managing business processes.

 ▪ Visio 2013 is the second version of Visio to employ the Office fluent user interface, 
commonly known as the ribbon. The Visio ribbon is well-designed and easy to use, 
in large part because the goal of the ribbon is to present sets of related functions 
visually, and Visio is a visual product.

 ▪ Tool tab sets and add-in tabs provide unique features and are only visible when they 
are relevant and can be used. Most ribbon tabs are visible all of the time.

 ▪ The Backstage view provides file management and option settings for Visio 2013.

 ▪ The drawing window and the Shapes window are the primary windows you will use 
to create and manipulate Visio diagrams.

 ▪ Visio provides a variety of keyboard shortcuts, mouse techniques, and specialized 
subwindows for panning and zooming within a diagram.
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Adding structure to  
your diagrams

IN THIS CHAPTER, YOU WILL LEARN HOW TO

 ▪ Compare containers and groups.

 ▪ Work with containers and their contents.

 ▪ Format and size containers.

 ▪ Add shapes to lists.

 ▪ Format and size lists.

 ▪ Find containers and lists in Visio (swimlanes, wireframes, and legends).

 ▪ Annotate shapes with callouts.

In many types of Microsoft Visio diagrams, it is useful to create visual or logical relationships 
among a set of shapes. In previous versions of Visio, you could use background shapes and 
groups for this purpose. These capabilities are still available in Visio 2013 as you discovered 
when you created a network diagram in Chapter 9, “Creating network and data center dia-
grams” However, Visio 2013 offers three more effective ways to establish relationships and 
add structure to diagrams:

 ▪ Containers A container provides a visual boundary around a set of objects, but it 
also establishes a logical relationship between the container and the objects within 
it: shapes know when they are members of a container and containers know which 
shapes they contain.

The key advantage of a container is that while you can move, copy, or delete it and 
its members as a unit, each contained shape maintains its independence. Selecting 
an object inside a container only requires one click, which makes it simple to access 
a container member’s shape data and other properties.

TIP A container can contain shapes, other containers, and lists.
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 ▪ Lists A list is a special type of container that maintains an ordered relationship 
among its members. Each object in a list knows its ordinal position; new objects 
are not merely added to a list but are added to a specific position in a list.

TIP A list can contain shapes and containers but cannot contain other lists.

 ▪ Callouts In previous versions of Visio, a callout was merely a shape that you glued 
to another shape to add a comment. A Visio 2013-style callout still provides a way to 
add annotation to a shape, but the callout knows the shape to which it is attached, 
and the shape can identify any attached callouts.

In this chapter, you will experiment with and learn the value of containers, lists, and callouts 
in Visio diagrams.

PRACTICE FILES To complete the exercises in this chapter, you need the practice 
files contained in the Chapter11 practice file folder. For more information, refer to 
“Downloading the practice files” in this book’s Introduction.

Comparing containers and groups
You can use either groups or containers to visually connect a set of shapes. However, the 
two have key behavioral differences that are likely to lead you to use one or the other de-
pending on your needs.

In this exercise, you will create both a group and a container, and then you will perform the 
same set of actions on each in order to examine the differences.

 SET UP You need the Containers, Lists and Callouts_start drawing located in the 
Chapter11 practice file folder to complete this exercise. Open the drawing in Visio 
and save it as Groups vs. Containers.

1 Create a colored rectangle and group it with the network shapes on the left side of 
the page.

SEE ALSO For a refresher on using a group with a background shape to organize a 
set of shapes, refer to “Organizing network shapes in a diagram” in Chapter 9.

2 Draw a bounding box around the Branch Office 2 network shapes on the right side 
of the page.
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3 On the Insert tab, in the Diagram Parts group, click the Container button. The 
Container gallery opens and as you point your mouse to the thumbnails in the 
gallery, Live Preview shows how each container style will look with your selected 
shapes. (Note that the Belt style is highlighted; you will use this style in the next step.)

TIP The 14 container styles in the gallery range in appearance from subtle to 
bold so you have an option to match the style of the container to the style of your 
diagram. The following graphic offers five very different looks for a set of Network 
shapes. 

4 Click the Belt thumbnail in the Container gallery. Your diagram now shows a set of 
grouped shapes on the left and a container on the right.
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5 Click the Branch Office 1 group once to select it, and then drag the bottom resize 
handle down to the bottom of the page.

6 Click the edge or heading of the Branch Office 2 container once to select it, and then 
drag the bottom resize handle down to the bottom of the page.

IMPORTANT One immediate difference to note is that you can select a group by 
clicking anywhere on its edge or interior, but you can only select a container by clicking 
its edge or its heading. 

The following graphic illustrates that what you’ve previously learned about groups 
applies here: resizing the group resizes the shapes in the group. Look at the container 
on the right, however. The container is taller but its member shapes are unchanged.

TIP If you run Visio in developer mode, you can change the behavior of a group so 
the interior shapes do not resize. For more information about developer mode, refer 
to the Appendix.

7 Press Ctrl+Z twice to undo both resize operations.

8 Drag two PC shapes from the Computers and Monitors stencil, dropping the first 
in the open area above the Branch Office 1 network segment and the second in the 
open area of the container for Branch Office 2.
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TIP Containers provide visual feedback when you drag shapes near or into them. 
(This is one way to distinguish a container from a group or an ordinary shape.) The 
border of the container on the right in the following graphic shows a green color that 
is very similar to the coloring used for Dynamic Grid lines (also visible in the graphic). 

9 Hold down the Shift key while clicking both the group and the container to select 
them, and then drag the selection down to the bottom of the page. As the follow-
ing graphic shows, dropping a shape on a group does not add it to the group—it 
remains behind when you move the group. In contrast, dropping a shape into a con-
tainer adds it to the container, so it moves when you move the container.

TIP By default, shapes dropped on a group are not added to the group. However, if 
you run Visio in developer mode, you can change the behavior of a group so it will 
accept dropped shapes. For more information about developer mode, refer to the 
Appendix.
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10 Press Ctrl+Z three times to undo the move operation and delete the two PCs you 
added.

11 Click once to select the Branch Office 1 group, and then click the printer in the 
group. Drag it out of the top of the group rectangle.

TIP The default behavior for groups is that the first click selects the group; you must 
click a second time to select a shape in the group. If you run Visio in developer mode, 
you can alter the selection characteristics of a group. For more information about 
developer mode, refer to the Appendix.

12 Click once to select the printer in the Branch Office 2 container, and then drag it out 
of the top of the container. The results of both this step and the previous step are 
shown in the following graphic.

TIP One click is sufficient to select any shape in a container because, by design, the 
fill of the container can’t be selected with a mouse click.

13 Hold down the Shift key while clicking both the group and the container to select 
them, and then drag the selection down to the bottom of the page. Although you 
have relocated the printer on the left outside the colored group rectangle, the shape 
is still part of the group. Consequently, the printer moves when you move the group. 
On the right, however, dragging a shape out of a container removes it from the con-
tainer; therefore, it stays behind when you move the container.
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14 Press Ctrl+Z three times to undo the move operation and return the printers to their 
original locations.

15 Click and drag in the interior of the group and attempt to draw a bounding box 
around the two PCs below the network segment. The result will not be what you 
intended. You cannot select the two PCs with a bounding box because dragging 
within the group shape moves the group (refer to the left side of the graphic in the 
next step).

TIP You can select shapes in a group with a bounding box—but only if you start the 
bounding box outside of the group.

16 Click once in the interior of the container and attempt to draw a bounding box 
around the two PCs below the network segment. A bounding box inside a container 
does select contained shapes for the same reason that you could select a contained 
shape with a single click in step 13: the container background is invisible to mouse 
clicks.

17 Click once to select the Branch Office 1 group, type San Francisco, and press Esc. 
Then format the text to 16 pt. and Bold to make it more visible. Because the new text 
falls directly on top of an Ethernet segment that is a similar color, the text is all but 
invisible.

18 Click once to select the container, type Boston, and press Esc. Then format the text to 
16 pt. and Bold to make it more visible. Notice that changing the font characteristics 
of the group makes the same changes to the text on all shapes within the group.

In the following graphic, the text you added to the group on the left is positioned 
in the center of the group by default. Because the default position and color render 

11

 Comparing containers and groups    423



the text invisible, you may want to use the text manipulation skills you learned in 
Chapter 3, “Adding sophistication to your drawings,” to move the text to a better 
position.

In contrast, a container has a built-in header. When you select a container and type 
text, the words automatically appear in the header. Changing the format of the header 
text does not affect the text on any shapes within the container.

+  CLEAN UP Save your changes to the Groups vs. Containers drawing, and then close it.

After completing this exercise, you should have a good working knowledge of the proper-
ties of groups compared to containers. For future reference, the following table contains a 
summary of the key differences.

Action Groups Containers
Resizing Contents are resized with the group Contents are not changed
Selecting an interior 
shape

Requires two clicks (unless default 
group behavior has been changed)

Requires one click

Selecting interior shape(s) 
with a bounding box

Cannot start a bounding box by 
clicking inside a group

Can start a bounding box by 
clicking anywhere

Dropping a new shape 
inside

Dropped shapes are not added to the 
group (unless default group behavior 
has been changed)

Dropped shapes are added to 
the container

Dragging a shape out Shape is physically outside the group 
but remains part of the group

Shape is removed from the 
container

Typing text Text is placed in the center of the 
group

Text is placed in the 
container’s heading
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SEE ALSO For more information about Visio 2013 containers, refer to the Visio development 
team blog at blogs.office.com/b/visio/archive/2012/11/05/containers-and-callouts-in-visio.aspx. 
Although the appearance of containers changed considerably between Visio 2013 and  
Visio 2010, the following Visio 2010 articles still contain useful information: blogs.msdn.com/b/
visio/archive/2009/08/25/organizing-diagrams-with-containers.aspx and blogs.msdn.com/b/
visio/archive/2009/08/27/details-on-container-behaviors.aspx. Finally, for the technically 
inclined, this post provides details about the inner workings of containers, lists and callouts: 
blogs.office.com/b/visio/archive/2010/01/12/custom-containers-lists-and-callouts-in-
visio-2010.aspx.

Organizing shapes with containers
Group shapes are still valuable for many purposes, including holding collections of sub-
shapes that will never change. However, Visio 2013 containers offer numerous advantages 
for dynamically grouping, moving, and managing a set of related shapes. 

In this exercise, you will continue working with containers to learn more about their unique 
properties.

 SET UP You need the Containers, Lists and Callouts_start drawing located in the 
Chapter11 practice file folder to complete this exercise. Open the drawing in Visio 
and save it as Container Properties.

1 Draw a bounding box around the Branch Office 1 network shapes.

2 On the Insert tab, in the Diagram Parts group, click the Container button, and then 
click Wire.

3 Right-click the edge or heading of the container to select it. Notice that whenever 
you select a container, the Container Tools tool tab set appears and includes the 
Format tool tab, as shown in the following graphic.

4 In the Container Tools tool tab set, click the Format tool tab to activate it.
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5 On the Format tab, in the Membership group, click the Select Contents button. All 
contained shapes are selected.

TIP You can also right-click the edge or heading of the container, click Container, and 
then click Select Contents to achieve the same result.

6 Draw a bounding box to select the Branch Office 2 network segment and the PCs 
below it; do not select the server and printer above it.

7 On the Insert tab, in the Diagram Parts group, click the Container button, and then 
click Wire. You have created a container around part of the Branch Office 2 network 
components.

8 Click the edge or heading of the container you just created and drag the top resize 
handle up until the container surrounds the server and printer.

9 On the Format tab, in the Membership group, click the Select Contents button. 
Notice that the server and printer are not selected. Surrounding shapes with an exist-
ing container do not add them to the container.
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10 Click once on the server shape to select it.

11 Right-click the selected server, click Container, and then click Add to Underlying 
Container. The server shape is now a member of the container.

TIP When you select any shape that is a member of a container, the green outline 
appears on the border of the container.

12 Click once on the edge or heading of the Branch Office 2 container to select it, and 
then press the Delete key. The container and its contents are deleted.

If you want to remove a container but leave its contents, the simplest method is to 
disband the container.

13 Click once on the edge or heading of the Branch Office 1 container to select it.

14 On the Format tab, in the Membership group, click the Disband Container button. 
The container is removed from the drawing but all of the previously contained shapes 
remain on the page.

TIP You can also right-click the edge or heading of the container, click Container, and 
then click Disband Container to achieve the same result.

+  CLEAN UP Close the Container Properties drawing without saving changes.

In this exercise and the preceding one, you selected a set of existing objects and created 
a container around them. You can also create an empty container and later add objects to 
it. To do so, ensure that nothing on the drawing page is selected. On the Insert tab, in the 
Diagram Parts group, click the Container button, and then click a container style in the gal-
lery. The new container will be added to the center of the drawing window. You can then 
drop in new or existing shapes, lists, or other containers.

TIP You can copy a container and paste it elsewhere in the same or a different drawing. A 
copy of the container and all its members will be pasted into the new location. 
 
The Lock Container button in the Membership group of the Format tool tab prevents 
shapes from being added or removed; it also locks the container against deletion.
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Formatting containers
When you drop a container onto the page, it includes a set of style attributes. You can 
change a container’s formatting at any time by selecting it and then using the commands 
on the Format tab of the Container Tools tool tab set. 

 ▪ You can use the Style gallery in the Container Styles group to select a different 
container style. (Be sure to notice the drop-down arrows at the right end of the 
Container gallery; use them to view additional container styles.) The container style 
options are also available by clicking the Change Shape button, either in the Editing 
group on the Home tab, or on the Mini Toolbar that appears when you right-click a 
container.

 ▪ You can choose alternate heading styles by clicking the Heading Style button in the 
Container Styles group. Visio offers either two or four heading styles, depending on 
the container.

There are two additional ways to alter the appearance of a container.

 ▪ Containers react to Themes and Variants. Consequently, the colors of the thumbnails 
in the Containers gallery and the containers on your drawing page can be very differ-
ent from one diagram to the next.

 ▪ You can change the fill, line, and shadow attributes of a container by using the same 
techniques you use for any other Visio shape—on the Home tab, click any button in 
the Shape Styles group.
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Sizing containers
The predesigned containers in Visio 2013 expand automatically when you add shapes near 
the edge of the container. You can change this default behavior by using the Format tool 
tab of the Container Tools tool tab set: in the Size group, click the Automatic Resize button 
to reveal three mutually exclusive options.

 ▪ No Automatic Resize The container will not expand when you drop shapes near 
the edge.

 ▪ Expand as Needed The container will expand when you drop shapes near the edge. 
The opposite is not true: however, the container will not shrink when you remove 
shapes.

 ▪ Always Fit to Contents The container will expand and contract automatically when 
you add or remove shapes.

You can also affect container size with the two buttons located above and to the left of the 
Automatic Resize button shown in the preceding graphic:

 ▪ Margins Sets the spacing between the edges of the container and the contained 
shapes.

 ▪ Fit to Contents Sets the container size to the minimum required for the contained 
shapes plus the margin.
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On the border
As you have already learned, when you drag a shape into a container, a green outline 
appears on the border of the container. This is true even when you drag most but not all 
of the shape into the container. In the following graphic, the wireless access point will be 
added to the container when the mouse button is released, even though it is not fully 
within the borders of the container. (Depending on the resize options described just be-
fore this sidebar, the container may expand to encompass the new shape.)

The following graphic on the left shows a different container behavior that you might 
use from time to time. In contrast to the previous graphic, the wireless access point 
has not been dragged quite as far into the container. The container signals the differ-
ence by displaying a green outline only on the top border and not all the way around. 
When the shape is dropped, the wireless access point will become a member of the 
container, but it will be attached to the edge of the container.
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The key difference in behavior of a boundary shape is that when the container is re-
sized, the boundary shape stays on the border. For example, when the resize handle 
on top of the container in the right-hand image in preceding graphic is dragged up-
ward, the wireless access point remains on the container boundary.

You might use border shapes for a situation like the one shown in this network dia-
gram because the wireless access point is attached to the branch office network but is 
also linked to other networks. Consequently, it makes sense to show it on the border 
rather than in the interior of the container. The “Wireframes” section of “Finding con-
tainers and lists in Visio” later in this chapter, contains another use for border shapes.

Adding shapes to lists
A list is a special type of container that maintains its members in ordered sequence. When 
you drop an object into a list, it takes a specific place before, between, or after existing 
members. Each list member knows its relative position in the list.

Visio 2013 doesn’t provide a list gallery on the Insert tab in the same way that it offers a 
container gallery. Consequently, creating a list either requires reusing an existing list shape 
or having enough technical knowledge to make changes to the ShapeSheet. (For more in-
formation about modifying the ShapeSheet, refer to the Appendix.) 
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In this exercise, you will add shapes to a list, and then reorder the shapes within the list. 
For this hypothetical scenario, the list shape is called My New PC; you will add rectangular 
shapes that represent the software you will load onto your new PC. Your goal for this exer-
cise is to create a list that shows the installation sequence for your new PC.

IMPORTANT The shapes you will drop into the list in this exercise have been prepared with 
two special attributes:

 ▪ Each shape displays the name of a software product. (The name of the product is stored in 
the shape as shape data.)

 ▪ Each shape displays its relative position in the list when it is in a list. When the shape is not in 
a list, it doesn’t display any number.

 ▪ The first attribute uses a Visio field to display shape data; refer to Chapter 3 for more infor-
mation about Visio fields. The second attribute was created specifically for this exercise and 
uses two ShapeSheet formulas to determine and present each shape’s position in the list; 
refer to the Appendix for information about the ShapeSheet.

 SET UP You need the Containers, Lists and Callouts_start drawing located in the 
Chapter11 practice file folder to complete this exercise. Open the drawing in Visio 
and save it as Lists. Then go to the Lists page.

1 Drag Visio 2013 into the list.

TIP A list provides the same visual feedback—a green border—as a container when a 
shape approaches its interior.

The graphic on the left shows the list outlined as the Visio 2013 shape approaches, 
and the graphic on the right shows the shape inside the list. Notice that the shape 
now displays its ordinal position in the list in front of the product name.

2 Because you can’t install Visio until after you’ve installed Windows, drag Windows 8 
into the list, above Visio 2013. As you approach the list with the Windows 8 shape, 
notice that an orange insertion bar appears to tell you where you can add a new list 
member. In this example, you can insert the new shape after the existing shape (the 
following graphic on the left) or before the existing shape (graphic in the center).
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When you drop Windows 8 above Visio 2013, notice that each rectangle displays its 
current position in the list. Visio 2013 is now #2.

TIP The blue triangle that appears at the end of the orange insertion bar in the 
previous left and center graphics and in several of the following graphics will be 
explained in the next section.

3 Insert Office 2013 between Windows 8 and Visio 2013.

4 Drop Mozilla at the end of the list.

5 Drag Visio add-in until the orange insertion bar appears below Mozilla, but stop 
when the pointer is on the edge of the list but most of the shape is still outside of it, 
as shown in the following graphic on the left. 

6 With Visio add-in in the position shown on the left in the following graphic, release 
the mouse button. When you release the mouse button from this position, the shape 
jumps into the list producing the result shown on the right.
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The behavior demonstrated by the Visio add-in shape highlights two differences be-
tween containers and lists:

 ▪ Container members can be located anywhere within a container; list members are 
always in fixed positions.

 ▪ Shapes that are dragged onto the border of a container can be attached to the 
border; shapes cannot be attached to the border of a list.

7 Drag Mozilla up so it is located between Windows 8 and Office 2013.

The following graphic on the left shows the Mozilla shape as it is being dragged up 
the list; the graphic on the right shows the result. Notice that when you release the 
mouse button, each shape immediately reflects its new position in the list.

As this step illustrates, you cannot only add shapes to specific positions in a list, you 
can rearrange the shapes within a list. 

Although you aren’t likely to use a Visio list for the specific purpose suggested by this ex-
ercise, you can probably imagine your own applications for position-aware shapes. Refer to 
the subsections in “Finding containers and lists in Visio” later in this chapter for examples of 
several ways that lists are used in Visio 2013 templates.

The previous exercise used a vertical list with shapes automatically placed from top to bot-
tom. A Visio list can be either vertical or horizontal and can order shapes in either direction 
within the list. Although these attributes are controlled by parameters and don’t require 
writing code, you can’t change them from the Visio ribbon; you must make changes to the 
ShapeSheet for the list.

SEE ALSO You will learn about the Visio ShapeSheet in the Appendix.

If you would like to experiment with a horizontal list, the Lists page in the Containers, Lists 
and Callouts_start drawing located in the Chapter11 practice file folder also includes a hori-
zontal list called Store Shelf. Drag shapes from the Computers And Monitors or Network 
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And Peripherals stencils to create a list like the following example. The Store Shelf list is con-
figured to add shapes from left to right so it expands to the right as you add shapes.

SEE ALSO If you would like to know more about lists, go to msdn.microsoft.com/en-us/
library/ff959245.aspx, which offers a comprehensive MSDN article on structured diagrams 
written by Mark Nelson of Microsoft.

+  CLEAN UP Save your changes to the Lists drawing, and then close it.

Formatting and sizing lists
You can adjust most of the same format and size options for a list that you can for a con-
tainer with one notable exception: you cannot change the size of a Visio list shape. Visio 
expands and contracts each list shape so it is the exact size of its member shapes plus the 
margin around the shapes.

The Format tool tab in the Container Tools tool tab set provides the functions described in 
the following list.

In the Size group:

 ▪ You can use the Margins button to adjust the spacing between the edges of the list 
and the contained shapes.

 ▪ Because Visio controls the size of a list shape, Fit To Container and Automatic Resize 
are disabled.

In the Container Styles group:

 ▪ If you open a diagram created in Visio 2010 that contains a list, you can select one of 
10 alternate styles for the list. However, at present, Visio 2013 does not allow you to 
change the style of lists created in Visio 2013. 

 ▪ The Heading Style gallery provides either two or four heading placement and style 
alternatives, depending on the list style.
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In the Membership group:

 ▪ The Lock Container, Select Contents, and Disband Container buttons provide the 
same functions for lists that they do for containers. 

Finding containers and lists in Visio
Several Visio 2013 templates take advantage of the properties of containers and lists to 
enhance ease of use and to add valuable features. In this section, you will discover three 
examples.

Swimlanes
One of the most prominent examples of list and container usage is for cross-functional 
flowcharts, also known as swimlane diagrams. (Refer to Chapter 4, “Creating flowcharts 
and organization charts,” for more information about this type of diagram.) 

The swimlane add-in was completely redesigned for Visio 2010 in order to take advantage 
of both lists and containers, with the net effect that a cross-functional flowchart (CFF) is a 
list of containers! The Visio 2010 structure is also used for Visio 2013 swimlane diagrams:

 ▪ The framework that holds swimlanes is a list.

 ▪ Each swimlane is a container.

IMPORTANT Because Visio 2010 swimlanes also use containers, if you open a 2010 swimlane 
diagram in Visio 2013, it will open directly. However, if you open a swimlane diagram created 
in an earlier version of Visio, it will be converted to the new swimlane structure and cannot 
subsequently be edited with the older software. To protect you, Visio presents the dialog box 
shown in the following graphic so you have the opportunity to save the older version of the 
diagram if you want to.
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In this exercise, you will create part of a swimlane diagram to understand how lists and 
containers are used.

 SET UP Click the File tab, and then click New. Click Categories, click Flowchart, and 
then double-click the Cross-Functional Flowchart thumbnail to create a new drawing.

1 Click the top edge of the CFF, and then type Sample Swimlane Diagram. Because the 
CFF structure is a list, the text you typed appears in the list heading.

2 Click the rectangle at the left end of the upper swimlane, and then type Accounting. 
Because the swimlane is a container, your text appears in the container heading.

3 Click the rectangle at the left end of the lower swimlane, type Legal, and then press 
the Esc key. The following graphic shows the results of steps 1, 2, and 3.
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4 Drag a Process shape into the Accounting swimlane. Notice that the swimlane 
shows the green border that you previously learned was characteristic behavior 
for containers.

5 Drag a Decision shape into the Legal swimlane and position it to the right of the 
Process shape in the Accounting lane.

6 Drag the AutoConnect arrow on the right side of the Process shape to link that 
shape to the Decision shape.

SEE ALSO Refer to Chapter 2, “Creating a new diagram,” for a refresher on using 
AutoConnect.
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7 Position the cursor just outside the CFF frame at the junction between the 
Accounting and Legal swimlanes (the pointer is visible in the following graphic).

TIP If the insertion bar isn’t visible when you first position the cursor near the lane 
boundary, pause just a moment longer and it will appear. 

The presence of the list insertion bar on the boundary between the Accounting and 
Legal lanes provides visible evidence that you are working with lists. Also, be sure to 
note the blue insertion triangle that appears at the end of the insertion bar. Clicking 
the blue insertion triangle automatically adds the default insertion object at the in-
sertion bar location.

TIP Not all lists have a default insertion object. If you click the blue insertion triangle 
on a list without a default, Visio will insert a copy of one of the adjacent list members.

8 Click the blue insertion triangle, shown in the previous graphic. Visio inserts a new 
swimlane between the other two and maintains all existing connections between 
shapes in the lanes. 11
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9 Click in the heading area of the Accounting swimlane and drag it down below the 
Legal lane. Visio moves the Accounting lane to the end of the list and maintains the 
connections between shapes within and across all swimlanes.
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+  CLEAN UP Save and close your diagram if you want to keep it; otherwise, just close it.

Adding, deleting, and rearranging swimlanes is more predictable and logical in Visio 2013, 
because containers and lists provide the underlying structure.

Swimlane diagrams derive another benefit from being built as containers: shapes in the 
container know they are contained. To find evidence of this, examine the Function field in 
the shape data for any flowchart shape in a swimlane. As an example, the following graphics 
show the shape data for the process shape (on the left) and decision diamond shape (right) 
from the preceding graphic. The value in the Function field is derived dynamically from the 
swimlane heading; if you change the value of the swimlane title, the Function field will be 
updated for all contained shapes.

SEE ALSO For more about swimlane containers, go to the Visio development team blog at 
blogs.msdn.com/b/visio/archive/2009/09/01/cross-functional-flowcharts-in-visio-2010.aspx.

IMPORTANT The following section applies only to the Professional edition of Visio 2013.

Wireframes
Visio 2013 includes a revamped set of user interface (UI) design shapes that were initially 
introduced in Visio 2010. For this chapter, the key point of interest about the redesigned 
shapes is that many of them are either containers or lists.

Software designers use wireframe shapes to create mockups of dialog boxes and other 
visual elements that will be displayed by their applications. When you use Visio 2013 to 
create a mockup of a dialog box, you will find that the Dialog Form shape is a container. 
Consequently, as you add buttons and controls to your dialog form, they become container 
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members. If you move, copy, or delete your dialog box, all of the contained shapes are in-
cluded. If you have ever created a UI mockup using Visio 2007 or earlier, it won’t take more 
than a moment or two of experimentation to realize how significant an improvement this is.

Some Visio 2013 UI shapes are lists, including, not surprisingly, the List Box control. When 
you drop one into a dialog form container, the list is prepopulated with three list members. 
You can add, delete, and resequence list members by dragging them, as you learned in 
“Adding shapes to lists” earlier in this chapter.

In this exercise, you will use the Wireframe template to build a prototype of a simple dialog 
box that looks like the one in the following graphic. Even if you aren’t a UI designer, you 
should find this exercise useful in learning more about the behavior of containers and lists.

 SET UP Click the File tab, and then click New. Click Categories, click Software and 
Database, and then double-click the Wireframe Diagram thumbnail to create a new 
drawing.

1 Drag a Dialog form shape from the Dialogs stencil, drop it on the page, and then 
zoom in so you can work with the shape.

2 Drag a Dialog button shape from the Dialogs stencil and glue it to a connection 
point in the upper-right corner of the dialog form. 
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TIP As soon as you drag the Dialog Button shape into the Dialog Form shape, notice 
that the edges of the Dialog Form shape are marked with the green outline that 
characterizes a container.

When you drop a Dialog Button shape onto the page, it automatically opens the 
Shape Data dialog box.

3 In the Shape Data dialog box, click OK to accept the default value for Type.

4 Drag another Dialog button shape into the dialog form container and glue it to the 
left end of the previous one; when the Shape Data dialog box opens, click Maximize 
in the Type list, and then click OK. Repeat a third time and select Minimize in the 
Type list.

TIP The Dialog Button shape is a multi-shape; the data value you select in the Shape 
Data dialog box determines the appearance of the shape.

The top of your dialog form container now looks like the following graphic.

5 Drag a Panel shape from the Dialogs stencil and drop it onto the page below (not 
inside) the dialog form. You need to drop it outside the dialog form, because it is too 
large to fit inside, and you want it to become a member of the Dialog container. (If a 
shape doesn’t fit inside a container, it will not become a container member.)

6 Use the Size & Position window or the resize handles to change the width of the 
Panel shape to approximately 3 inches (75 mm) and its height to about 1.25 inches 
(30 mm).

7 Drag the Panel shape into the dialog form and position it in the bottom center. 
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TIP The Panel shape is a container, so you can only select and drag it by its edges. 

8 Drag an Upper tab item shape from the Dialogs stencil, position it as a Boundary 
shape at the upper-left corner of the panel container, type Tab 1, and press Esc.

TIP You want the Upper tab item shape to be on the boundary of the Panel shape 
and not inside it. Consequently, when you position the Upper tab item shape, make 
sure that only the top border of the panel container shows the green highlight, as 
shown in the following graphic. Refer to the sidebar “On the border” earlier in this 
chapter for more information about border shapes.

By attaching the Upper tab item shape to the boundary of the panel container, you 
have “welded” them together. If you reposition the panel container, the tab follows 
along.
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TIP Notice that the top border of the panel container is not the only thing with a 
green outline in this graphic. There is also a green outline surrounding the dialog 
form container. This is because you are adding the Tab shape to a container that is 
nested inside another container; both containers reflect your action.

9 Drag another Upper tab item shape from the Dialogs stencil, position it as a 
Boundary shape to the right of the previous tab, type Tab 2, and press Esc.

10 Drag a List box from the Controls stencil and position it in the upper-left corner of 
the panel container as shown in the following graphic.

TIP The List Box shape exhibits behavior you haven’t learned about yet in this 
chapter. When you release the mouse button to drop the new list, it automatically 
adds several list items, as shown in the following graphic. A List shape that automat-
ically adds list entries can be very useful, but creating one that behaves this way is 
beyond the scope of this book. 
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11 Select the uppermost Text item and type A, select the middle Text item and type D, 
and then select the bottom Text item and type E.

12 Position the cursor just to the left of the Column 1 list shape, between the A and D 
labels.

13 Click the blue insertion triangle twice to add two entries to the List Box shape, and 
then type B into the upper item and C into the lower one.

TIP The Dialog Form shape in this graphic is taller than the ones in step 10. That’s 
because the list box, panel container, and dialog form container are all configured 
for automatic expansion. When you added new list items, the list expanded, which, 
in turn, caused both of the surrounding containers to expand.

14 Click once on the outer edge of the Dialog form shape to select it.

15 On the Format tab of the Container Tools tool tab set, in the Size group, click Fit to 
Contents. The Dialog form container shrinks to fit the size of the Panel container lo-
cated within it.
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+  CLEAN UP Save and close your diagram if you want to keep it; otherwise just close it.

The dialog box mockup you’ve created in this exercise isn’t going to win any design awards. 
If you wanted to create a real mockup, you would add additional controls, text, colors, and 
themes. However, by completing this exercise, you have created a practical application for 
nested containers and lists, and have an example of a container with a border shape.

SEE ALSO For more information about wireframe design, refer to the Visio development team 
blog at blogs.msdn.com/b/visio/archive/2009/12/22/wireframe-shapes-in-visio-2010.aspx.

IMPORTANT The following section applies only to the Professional edition of Visio 2013.

Legends
In Chapter 10, “Visualizing your data,” you learned about data graphics and created a leg-
end for your data graphics. A data graphics legend is actually a structure consisting of an 
outer list, one or more containers as list members, and lists within those containers. For ex-
ample, the same legend is shown in both of the following graphics. The structure is loosely 
visible on the left. However, after drawing a bounding box around the entire legend, the 
structure is very apparent on the right: the legend consists of three containers (Legend, 
Owner, Risk) and two lists, all of which are outlined in green.
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If you return to the data graphics diagram you created in Chapter 10 (or open the Data 
graphics legends_start file in the Chapter11 practice files folder), you will find that you can 
add, delete, rename, and move legend components. Throughout your changes, however, 
the legend maintains its overall structure because of the nested containers and lists.

Annotating shapes with callouts
In previous versions of Visio, you could drag a callout from the Callouts stencil onto the 
drawing page. The Callouts stencil still exists: in the Shapes window, click More Shapes, click 
Visio Extras, and then click Callouts to reveal more than three dozen callout types. The fol-
lowing graphic shows four examples. 

Old-style callouts are useful for their intended purpose: you can type text into the text box 
and glue the tail onto another shape. Some even have attractive or clever designs.

The underlying problem with the older callouts, however, is that most of them are just 
shapes. Although you can attach them to other shapes, they aren’t associated with those 
shapes in any useful way. For example, start with the printer and callout on the left in the 
following graphic.

 ▪ Moving the printer to the right (center image), doesn’t change the location of the 
callout.

 ▪ Deleting the printer shape (rightmost graphic) doesn’t affect the callout.
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It’s also easy to accidentally detach the callout from the printer by dragging the text box 
portion of the callout while trying to relocate it.

In this exercise, you will discover that Visio 2013 callouts are associated with the shapes to 
which they are attached in ways that make sense; the callout and its attached shape act in 
tandem.

 SET UP You need the Containers, Lists and Callouts_start drawing located in the 
Chapter11 practice file folder to complete this exercise. Open the drawing in Visio 
and save it as Callouts. Then go to the Callouts page.

1 Click once on the Printer shape to select it.

2 On the Insert tab, in the Diagram Parts group, click the Callout button. The Callout 
gallery opens.

3 Point to various callout images in the gallery and notice that Live Preview shows what 
each callout will look like when attached to the printer shape.
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4 Click Orthogonal (as shown in the previous graphic). The callout is added to the page 
and attached to the printer. 

5 With the callout still selected, type Located in Accounting Department, and then 
press Esc to exit text edit mode.

TIP Notice that when the callout is selected, there is a green border around the 
printer to signal the association between the two shapes. The reverse is not true: if 
you select the printer, the callout does not have any kind of border.

6 Select and drag the printer to the right (shown on the left in the following graphic), 
and then release the mouse button (graphic on right). The callout moves with the 
printer.
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7 Select and drag the callout to the left side of the printer.

As you drag the callout, it looks like it’s been detached from the printer (left graphic). 
However, as soon as you release the mouse button, it is still attached to the printer 
(right graphic).

+  CLEAN UP Save and close your diagram if you want to keep the changes; otherwise 
just close it.

Unlike containers and lists, callouts do not have a context tab on the Visio ribbon. However, 
you can take advantage of the new change shape feature in Visio 2013 to switch any call-
out to a different style. Click the Change Shape button, either in the Editing group on the 
Home tab, or on the Mini Toolbar that appears when you right-click a callout. The following 
graphic takes advantage of Live Preview and the Mini Toolbar to illustrate changing the call-
out from the preceding graphics to the Zoom style.

‘
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There are a few other useful things to know about callouts:

 ▪ If you delete a callout, it doesn’t affect the shape to which it was attached. However, if 
you delete the shape, the callout is also deleted.

 ▪ If you copy a shape that has a callout attached, both the shape and the callout are 
copied.

 ▪ You can attach more than one callout to a shape.

 ▪ If you do not have any shapes selected when you insert a callout, Visio inserts the 
callout in the center of the drawing window.

 ▪ If you select more than one shape before inserting a callout, Visio will attach a callout 
to each selected shape.

 ▪ Callouts respond to Themes and Variants so their appearance on the page will remain 
consistent with the rest of your diagram.

SEE ALSO For more information about callouts, refer to the Visio development team blog at 
blogs.office.com/b/visio/archive/2012/11/05/containers-and-callouts-in-visio.aspx.
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Key points
 ▪ You can use containers and lists to achieve many of the same results that you can by 

creating a background shape and grouping it with a set of shapes. However, contain-
ers offer considerable advantages over grouped shapes:

 ▪ When you move, copy, or delete a container or a list, the member shapes in the 
container or list are also moved, copied, or deleted.

 ▪ Even though the previous statement is true, each shape in a container or list main-
tains its independence. It’s easy to select a container member with a single click 
and to access its shape data and other properties.

 ▪ Shapes in containers and lists know they are contained and can derive data from 
the parent container. (Refer to the example at the end of the Swimlanes topic in 
“Finding containers and lists in Visio,” earlier in this chapter.)

 ▪ Visio 2013 lists are a special type of container in which shapes are maintained in a 
specific sequence. Each shape knows its ordinal position in the list even when shapes 
are added, deleted, or rearranged.

 ▪ Visio 2013 uses containers and lists for cross-functional flowcharts, wireframe dia-
grams, data graphic legends, and other purposes. Visio also provides generic contain-
ers that you can use for any purpose you would like.

 ▪ Visio 2013 callouts are much more intelligent than the callouts provided with previous 
versions of Visio. In Visio 2013, each callout is associated with a specific target shape 
and is copied, moved, or deleted with that shape.

11
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Symbols
1-D shapes

behavior of, 75
identifying, 85–86

2-D shapes
connecting with dynamic connectors, 80–85
connecting with lines, 75–80
defined, 75

2-D single arrow shapes, 112
3-D formats. See Bevel effects
3-D rotation effect, 230
; (semicolon) for null (blank) entries, 255
.vsdx file format, 336

A
absolute hyperlinks, 305–310
Account page (Backstage view), 25–26
Action Tags, 474
Active Directory template, 386
active page, 37, 143, 149, 151, 320
Active property (layers), 135
Activity types (BPMN), 463
add-in tabs (ribbon), 33
Advanced tab (Save As Web Page dialog box), 491
Align buttons (Paragraph group), 115
aligning shapes

with align buttons, 204–208
with Auto Align & Space, 209–211
with dynamic grid, 54–58
with rules and guides, 63–66

anchor shapes, 206, 511
Apply Automatic Layouts to Shape Styles option, 

188
Apply button (Layer Properties dialog box), 139

area select (bounding box), 59
Arrange group, 128, 189
Arrange Subordinates option (org charts), 188
Arrows page name tab, 154
Assistant shapes (org charts), 178–179
attributes, shape data

changing, 250–256
viewing, 248–250

AutoAdd/AutoDelete, 91–94
Auto Align & Space feature, 209–210
auto-arrange options, 211
AutoConnect arrow, 163–164, 438
AutoConnect feature

about, 86
turning off, 91
using, 86–91

AutoHide (docked windows), 242
Automatically Open Web Page In Browser check 

box, 488
Automatic Link Wizard, 505, 507
Automatic Resize button (containers), 429
automatic text rotation, 112–114
Auto Size feature, 141–142
Auto Space, 207

B
background grid. See grid
background pages

about, 140–141, 154
adding to drawings, 148
associating with foreground pages, 141
and borders, 148–154
headers and footers, 325
templates and, 338–340

Index
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Backstage view
Account page, 25–26
Export page, 24
Info page, 16–17
New page, 17–19
Open page, 20–21
Options button, 26–27
overview, 15
Print page, 22
Save/Save As pages, 21–22
Share page, 23–24

Barn shape, 97
Basic Diagram thumbnail, 141
Basic Flowchart Shapes, 89
Basic Flowchart Shapes stencil, 161, 299
Basic Network Diagram, 354–359
Basic Network Shapes - 3D template, 362
Basic Network Shapes template, 353
Basic Shapes stencil, 141, 465
Belt org chart style, 186
Best Fit To Page button (org charts), 188
Bevel effects, 228–231
Blank Page button, 141
Block Diagram thumbnail, 108
Blocks Raised (Shapes window), 112
Blocks stencil, 109
blue circle handles, 79
BMP, creating from Visio drawings, 330, 335
bookmarks, creating in Word documents, 301
Boolean (shape data field type), 240
borders

applying line styles/colors to, 231–235
border shapes, 431–432
Borders & Titles gallery, 151

boundary shapes (containers), 431
bounding boxes

anchor shapes and, 206
selecting shapes in containers with, 423–424
selecting shapes in groups with, 423–424
selecting shapes with, 58, 111

Box shapes, 109

BPMN (Business Process Model and Notation)
2.0 template, 496
basics, 461–463
Basic Shapes stencil, 508
creating subprocesses, 468–472
creating/validating diagrams, 464–467

Brainstorming Diagram, 510
Bring to Front button, 204
Bubble Callout style, 402
Building Photo layer, 137–138
Business Intelligence in Microsoft SharePoint 2013 

(Microsoft Press), 495

C
Calendar attribute (shape data), 254
callouts

annotating shapes with, 448–452
defined, 418
old-style, 448–449

casino operation example (data-driven graphics), 
394

Center Of Rotation handle (pin), 69
Change Shape button, 428
Change Shapes feature, 97–100
Change Title button (Save As dialog box), 487
Check Diagram button, 457, 460
Clip Art box (Office.com), 132
Clouds theme, 214–215
Cloverleaf interchange, 100
coauthoring, 517–523
collaboration, 510–523
colors

applying fill colors/patterns to shapes, 222–228
Color gallery, 219
Color property (layers), 135
Create New Theme Colors, 218
Fill Color lists, 408
fill colors gallery, 217
glued vs. unglued lines, 77
Standard Colors, 96, 224
Theme Colors, 224
Variant Colors, 224
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comments
adding to Visio diagrams, 511–517
basics, 117–122
Comments page (Visio), 513
Comments pane (SharePoint), 501

Compatibility Mode (file formats), 545
Computers And Monitors - 3D stencil, 116
Computers and Monitors stencil, 356
Configure Refresh dialog box, 270–271
connecting

AutoConnect, 86–91
connection points (shapes), 76
shapes with dynamic connectors, 80–85
shapes with lines, 75–80

connectors
applying line styles/colors to, 231–235
Connector button, 170
Connector layers, 140
Connectors gallery, 219
Connector Tool, 81, 84–85, 110, 163
types (BPMN), 463

Connector Tool
automatically added shapes and, 170
on Home tab, 85
single-use on Mini Toolbar, 84, 110, 163

containers
basics, 417
comparing with groups, 418–425
Container Tools (tool tabs), 32
copying/pasting, 427
creating custom, 543–544
creating empty, 427
data graphic legends and, 447–448
disbanding, 427
formatting, 428–429
organizing shapes with, 425–427
sizing, 429–432
swimlane diagrams and, 436–441
wireframe shapes and, 441–446

control handles
at ends of 1-D shapes, 85–86
defined, 67
on dynamic connectors, 84
on freeform lines, 79
yellow, 70–71, 355–358

copying
data graphics between drawings, 411
formatting between shapes, 235–236
themes, 221
Visio websites, 493

copying/pasting
containers, 427
enhanced copy-and-paste function, 360
shapes, 60–63

Create from Selection button, 468
Crop Tool (Picture Tools Format tab), 197
cross-functional flowcharts (CFF). See also swimlane 

diagrams
about, 166–167
stencil, 169
tab (Arrange group), 168
thumbnail, 167

currency (shape data field)
about, 240
formatting, 251–252

custom formulas (fields), 538–539
customizing

Custom tab (Colors dialog box), 228
Quick Access Toolbar, 527–528
ribbon, 525–527
shapes and stencils, 529–531
themes, 218–219
Visio websites, 486–493

D
data

data center diagrams, 353–354
Data Selector wizard, 260–263, 504
Data tab (ribbon), 29
linking diagrams to external sources of, 258–267
shape data. See shape data

Database/External Data shapes, 89
data graphics

activation of, 260
applying to multiple pages, 398
casino operation example, 394
color assignments, 408
creating legends, 412–413
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creating new, 406–411
Data Graphics gallery, 396
editing, 399–406
legends using lists and containers, 447–448
network equipment diagram example, 390–392
process improvement workflow example, 393
refreshing data/data graphics, 414
risk management example, 394–395
using existing, 395–398

data linking
about, 259
refreshing linked data, 267–270
to shapes automatically, 272–275

date (shape data field)
about, 240
formatting, 254

Decision shapes, 438
Define Shape Data dialog box, 248
deleting

custom colors sets, 221
hyperlinks, 315
links between data rows and shapes, 265
shapes, 91–94

Department stencil, 127
Description box (hyperlinks), 298, 303
Designer, SharePoint, 473–474
Design tab

Background group, 153
ribbon, 28
Themes group, 108

detailed network diagrams, 359–362
Detailed Network Shapes template, 353
developer mode, 304, 420–421, 482, 532–534
Developer tab

adding to ribbon, 532–534
Code group on, 541
Show ShapeSheet button on, 534

diagrams
applying themes/variants/Quick Styles to, 212–

218
collaborating on

coauthoring, 517–523
commenting, 511–517
overview, 510–511

creating graphic images for shapes in, 330–335
enhancing with data-driven graphics, 390–395
enhancing with hyperlinks. See hyperlinks
linking to external data sources, 258–267
network. See network diagrams
previewing/printing, 320–325
publishing to web, 344–351
refreshing data in linked, 267–269
refreshing diagrams published to Visio Services, 

503–510
removing personal information from, 326–329
saving as templates, 338–342
saving in different file formats, 336–338
sharing with Visio Viewer, 343–344
validating, 457–461
validating BPMN, 464–467
workflow. See workflow diagrams (SharePoint)

dialog box launcher, 28, 108–109
Dialog form shapes, 442
Disband Container button, 427
Displayed Text column (reports), 381
Distribute Horizontally option, 207
Distribute Shapes dialog box, 211
documents

Document/Data shapes, 89
document types (Insert tab), 134
linking to, 296–299
linking to locations in, 299–301

drawing
Drawing Scale tab (Page Setup), 368
Drawing Tools drop-down menu, 364
scales, changing, 376–380
window, 36–39

duplicating
pages, 147
shapes, 60–63

duration (shape data field type)
about, 540
formats, 258

DWG file format, 336
DXF file format, 336
dynamic connectors, 80–85
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dynamic glue
1-D shape behavior and, 85–86
about, 82
connecting shapes with, 82–83

Dynamic Grid
aligning shapes with, 54–58, 110, 356
positioning with, 127
turning off, 58

E
editing

data-driven graphics, 399–406
Editing group, 135
edit mode (text boxes), 108
existing hyperlinks, 313–315
multiple shapes, 247, 250
shape data, 244–247

Effects button (Shape Styles group), 230
Effects gallery, 219
Effects menu, 229
Ellipse Tool, 57
email, linking to addresses, 296
Embellishment levels, 219
EMF/EMZ images, creating from Visio drawings, 

330, 335
End Event shapes, 470
End shapes, 236
equipment shapes, adding to rack diagrams, 

370–376
Ethernet shape, 354–358
events, BPMN, 462
Excel, Microsoft

building org charts from workbook data, 180–
186

changing data values in diagram-linked 
worksheets, 267–269

creating workbooks with org chart wizard, 198–
201

linking to locations in workbooks, 301
linking Visio Services diagrams to workbooks, 

503–510
linking workbook data to diagrams, 259–267
naming worksheets, 267

Executive shapes, 175

Export page (Backstage view), 24
external data sources, linking diagrams to, 258–267
External Data window

Configure Refresh dialog box, 270–271
displayed after automatic linking, 275
displayed after data linking, 264
show/hide, 29
using to create shapes, 264–267

F
Facet theme, 214–215
fields (shape data)

custom formulas in, 538–539
defining new, 256–257
Field dialog box, 538–539
inserting onto shapes, 125–126
linking to shape data, 125–126

files
File tab, 108
storage of Visio-generated, 493
Visio 2013 formats, 336, 544–545

fill colors
applying to shapes, 222–228
Fill Color lists, 408
gallery, 217

Find dialog box, 383
fixed line colors, 217
fixed list (shape data field type)

about, 240, 247
using, 254–255

flowcharts
adding Bevel and Reflection effects, 228–231
adding labels to, 165–167
creating, 161–164
Flowchart Category (File tab), 127
Flowchart layer, 135
flowchart rule set, 480
portrait vs. landscape orientation, 161–162
report, 276–280
validating, 457–461
in Visio Standard/Visio Professional, 157–160
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fonts
changing size of, 104, 106–107
Font group (Home tab), 107
Grow Font/Shrink Font button buttons, 106

formatting
containers, 428–429
copying between shapes, 235–236
date fields, 254
footers and headers in page setup, 324–325
Format attribute (shape data fields), 249
Format Painter, 235–236
Format Shape window, 223, 226
Format tool tab, 134
lists, 435
text boxes, 105–108

Freeform Tool, 78
functional bands, 166

G
Gas station shape, 97
Gateway shapes (BPMN), 465
Gateway types (BPMN), 463
GIF images

creating from Visio drawings, 330, 335
webpage output format, 492

Glow effects, 228–231
glue

dynamic, 82–83, 84–85, 477
Glue to Shape prompt, 82
identifying types of, 85–86
static, 81–83, 85–86, 477

Goldsmith, John, 537
Go To Page navigation panel, 488
Gradient fill option (Format Shape window), 226
Gradient stops section (Format Shape window), 226
graphics

creating, 330–335
data-driven. See data graphics

GRAVITY() function, 113
green handles, 81
grid

Dynamic, 54
off by default in Visio 2013, 37
turning on, 37

grouping shapes, 126–130
groups

comparing with containers, 418–425
vs. layers, 140

Grow Font button, 106
guides/rulers, positioning shapes with, 63–66

H
hand drawn themes, 220
handles

control, 70–71, 84, 85–86, 355–358
resize, 67–68, 75, 114, 116
rotation, 69, 73, 109–110, 114, 116
selection, 67
static glue and, 76, 81

Hard Edge thumbnail, 229
headers and footers in page setup, 324–325
Hidden attribute (shape data fields), 250
Hire candidate shape, 236
Home tab

ribbon, 27
Tools group, 105

horizontal lists, 434
Host In Web Page setting (Save As Web Page 

dialog box), 493
HSL color scheme, 228
HTML bookmarks, 296
hyperlinks

absolute, 305–310
adding multiple to objects, 315–316
basics, 293–294
editing existing, 313–315
hyperlink base property, setting, 310–312
Hyperlinks dialog box, 295, 373–374
linking

to documents, 296–299
to email addresses, 296
to locations in documents, 299–301
to Visio pages, 302–303
to websites, 294–296

overview, 292–293
relative, 305–310
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I
Ignore Rule option, 460
Ignore This Issue option, 460
Illustrations group, 131
Info page (Backstage view)

about, 16–17
Remove Personal Information, 326–329

information pane (SharePoint), 502
Insert button (Picture Group), 191
inserting pictures, 131–133
insertion bar (lists), 439
Insert tab

Illustrations group, 131
ribbon, 28
Text group, 125

Invite People function, 23
Ion thumbnail (Themes gallery), 227
Issues window

and Check Diagram button, 457, 477, 480
Ignore Issue, 459–460
Ignore Rule, 460
validating flowcharts, 457–461
validating SharePoint Workflows, 477

J
JPEG images

creating from Visio drawings, 330–333, 335
webpage output format, 492

K
keyboard shortcuts

centering pages in drawing window, 196
changing windows in Visio, 360
closing print preview, 321
copying/pasting shapes, 60
cursor to magnifying glass, 46
duplicating shapes, 62
following hyperlinks on Visio shapes, 294
full-screen view mode, 30
grouping selected shapes, 128
horizontal/vertical dragging, 64

Hyperlinks dialog box, 292
inserting pictures, 131
navigating foreground pages, 147
opening Find dialog box, 383
opening Hyperlinks dialog box, 373
opening print preview, 321
opening VBE window, 542
Pointer Tool activation, 116
repeating previous operation, 208
returning to full page view, 47
returning to normal operating mode, 58
ribbon tabs, 31
selecting shapes, 59
text edit mode, 104
undo, 112
zooming, 48

Keyboard tray shape, 372

L
Label attribute (shape data fields), 249
labeling shapes, 104–105
labels, adding to flowcharts, 165–167
Landmark Shapes stencil, 97
Language attribute (shape data), 254
Laptop shape, 225
lasso select, 59–60
layers

basics, 134–135
Connector, 140
creating and assigning shapes to, 135–139
Flowchart, 135–139

layout options (org charts), 185–188
LDAP Directory template, 386
legacy text formatting dialog boxes, 108–109
legends, data graphics, 412, 447–448
lines

connecting shapes with, 75–80
Line Format section (ShapeSheet), 536
Line Tool, 75
styles/colors, 231–235
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linking
data to shapes automatically, 272–275
to documents, 296–299
to email addresses, 296
to existing subprocess pages, 472
to locations in documents, 299–301
to other Visio pages, 302–303
refreshing data in linked diagrams, 267–269
to websites, 294–296

lists
adding shapes to, 431–434
creating, 543–544
data graphics legends, 447–448
defined, 418
delimiting entries with semicolons, 255
formatting, 435
List Box shape, 442, 445
list fields, types of, 247
sizing, 435
swimlane diagrams and, 436–441
wireframe shapes and, 441–446

Live Preview, 206, 230, 419
Lock Container button (Format tool tab), 427
locked text, 114
locked text blocks, 116
Lock property (layers), 135

M
macros

recording/running, 539–540
security settings, 540–541
vs. VBA, 542

Manager shapes, 176
Marker theme, 220
master objects, 35
Maximum Value/Minimum Value fields (data 

graphics), 404
metadata, removing from documents, 326–329
Metric diagrams, 19
metric templates (diagrams), 323
Microsoft Account (Live ID), 25
Microsoft Active Directory Topology Diagrammer 

add-in, 386
Microsoft Developer Network (MSDN), 473

Microsoft Silverlight, 486
Microsoft Word 2013 Step by Step (Microsoft 

Press), 301
minimizing ribbon, 34
Minimum Value/Maximum Value fields (data 

graphics), 404
Mini Toolbar, 110
Monitor shape, 372
More button (Themes gallery), 108
moving Visio websites, 493
multiple data sources, linking shapes to, 264
multiple hyperlinks, adding to objects, 315–316
multiple shapes

editing, 247, 250
Multiple Shapes stencil, 177

N
Name attribute (shape data fields), 249
named bookmarks (Word), 299
naming

image files, 194
shapes, 304–305

Network and Peripherals stencil, 123, 354
network diagrams

background/history, 353–354
building basic, 354–359
building detailed, 359–362
detailed network diagrams, 359–362
drawing scale, changing, 376–380
mapping Active Directory and LDAP, 386
network equipment diagram example (data-

driven graphics), 390–392
organizing shapes in, 363–364
rack diagrams, adding equipment to, 370–376
Rack Diagram template, 365–370
running computer/network reports, 381–382
searching/replacing text, 382–386

New Comment button, 119
New Data Graphic dialog box, 407
New Item dialog box, 407–410
New Layer dialog box, 136
New page (Backstage view), 17–19
null (blank) entries, 255
number (shape data field type), 240
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O
object types (Insert tab), 134
Office 2013, 343
Office 2013 Insert Pictures dialog box, 132
Office Furniture/Accessories stencils, 213
one-dimensional shapes

behavior of, 75
identifying, 85–86

Online Pictures button (Insert tab), 132
Open page (Backstage view), 20–21
Options button (Backstage view), 26–27
organization charts

adding photos to, 192–197
adding themes to, 191–192
Arrange group, 189
changing styles in, 192–197
creating by hand, 175–179
Organization Chart Wizard

create Excel workbooks with, 198–201
displaying Windows folder structure with, 

201
hiding sections of, 189
using with existing data, 180–186

Org Chart add-in, 33
overview, 173–174
Picture group, 191
selecting layout options, 187–188
Shapes group, 189–191

Organize Supporting Files In A Folder check box, 
488

orientation
flowchart considerations, 161
Orientation button (Page Setup group), 141
of shapes on pages, 108–112
of text in shapes, 112–114

P
pages/page setup

add/delete/reorder, 141–146
background, 161
basics, 140–141
changing drawing scale, 368–369, 376–380
changing orientation, 144, 323

Drawing Scale tab, 368–369, 376–380
foreground, 140
headers and footers, 324–325
linking to, 302–305
orienting shapes on, 108–112
page controls (drawing window), 37
Page Setup dialog box, 143–146, 323
Page Size tab, 145
page title text box, 105–108
Page Width button, 108
Print Setup tab, 144–145
resequencing, 146–147

pan and zoom
button on View tab, 48
buttons on Status bar, 48
example, 45–51
pane in website navigation panel, 347–349
in Visio Services, 494

Paragraph group, 115
Paragraph group (Home tab), 107
Parker, David, 481–482, 537
pasting shapes, 60–63
patterns

applying to shapes, 222–228
line, 232–234

PDF format (Visio 2010/2013), 337–338
Pencil Tool, 79
personal information, removing from diagrams, 

326–329
pictures/photos

adding to org charts, 192–197
adding to org charts with Picture group, 191
inserting, 131–133
Picture Tools (tool tabs), 32, 134

pin (Center Of Rotation handle), 69
Pin Pos menu, 73
PNG images

creating from Visio drawings, 330–335
webpage output format, 492

Pointer Tool, 57, 58, 106, 110
Position button (Arrange group), 210
positioning shapes with rulers/guides, 63–66
PowerPoint, Microsoft

creating presentations from Visio diagrams, 542
linking to locations in presentations, 301
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Power supply/UPS shape, 371
predefined reports, 275–280
preferences, theme, 221
Premium edition (Visio 2010), 8
previewing and printing diagrams, 320–325
printing

diagrams, 320–325
Printer shape, 226, 355
Print page (Backstage view), 22
Print property (layers), 135
Print Setup tab (Page Setup dialog box), 144–

145
Process and Decision shapes, 86
process diagrams, 455–456
process improvement workflow (data-driven 

graphics), 393
Process shapes, 90, 161–162, 438
Process tab (ribbon), 29
Professional edition, special features in, 6, 8–9. See 

also Visio 2013 Professional
Prominence theme, 214–215
Prompt attribute (shape data fields), 249
properties

custom, 122
groups vs. containers, 424
layer, 135–136
Properties dialog box, 326
Properties menu entry (context menu), 243

publishing
diagrams to web, 344–351
Publish button (Save As dialog box), 486–488
Publishing Options section (Save As Web Page 

dialog box), 489
Publish Settings dialog box, 498

Q
Quick Access Toolbar

customizing, 27, 527–529
keyboard shortcuts and, 31
Save button on, 501, 506–509
Undo button on, 188

Quick Shapes
AutoConnect and, 86–91
creating flowcharts with, 161–165
Shapes window, 530

Quick Styles, 212–218

R
rack diagram

adding equipment shapes to, 370–374
changing drawing scale, 376–380
creating, 365–370
downloading shapes and stencils, 375
enhancing, 376

Rack Mounted Servers stencil, 362
RBG color scheme, 228
recording macros, 539–541
Rectangle Tool, 57
Reflection effects, 228–231
refreshing

data/data graphics, 270–271, 414
data in linked diagrams, 267–269
diagrams published to Visio Services, 503–510

relative hyperlinks, 305–310
Re-Layout button (org charts), 188
Re-Layout button (Org Chart tab), 179
Remove Hidden Information dialog box (diagrams), 

328–329
Reorder Pages dialog box, 146–147
replacing shapes, 95–96
Reply area (comment edit box), 121
Report: Milestones by Start Date check box, 489–

490
reports

creating new, 281–285
flowchart, 276–280
modifying, 287–288
network and computer, 381–382
predefined, 275–280
Report Definition Wizard, 281, 287

repositioning
shapes, 66–75
text/text blocks, 114–117

Reset Connector function, 84
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resizing
containers, 420, 429
handles for, 114
lists, 435–436
shape groups, 129
shapes, 66–75
Shapes window, 39–42
text blocks, 116

Reveal Tags (Comments group), 122
Review tab

Comments group, 119, 122
ribbon, 29

ribbon, Visio
about, 9–13
add-in tabs, 33
appearance of, 9–13
customizing, 525–527
keyboard shortcuts, 31
minimizing/restoring, 34
opening shape data window from, 243
tabs overview, 27–30
tool tab sets, 32

risk management (data-driven graphics), 394–395
Road Shapes stencil, 95
Road square shape, 96–97
Room shapes, 213
rotating

shapes, 108–112
shape text, 112–114

rotation handles, 69, 73, 109–110, 114, 116
Roth, Chris, 537
Rounding presets (Format Shape window), 234
Router 1 shape, 372
Router shape, 358
rulers/guides, positioning shapes with, 63–66
rules, Visio

basics, 456–457
creating new validation, 481–482
flowchart validation, 457–461
reusing existing validation, 479–482
Rules Tools software, 482
sets, 457, 479, 481

S
saving

drawings as templates, 338–340
drawings in different file formats, 336–338
Save As file types, 330–331
Save as Web Page dialog box, 487–488
Save/Save As pages (Backstage view), 21–22
Save To Cloud button, 23
Visio drawings to SharePoint 2013, 495–502

scaled drawings, 376–380
scheduling data refresh, 270–271
screen magnification, 12–13
screen resolution, 11–12
ScreenTips, 117–122
SDL diagram flowchart template, 160
searching

and replacing text, 382–386
Search Pages check box, 488
Search Pages pane, 349–350

security (macros), 540
selecting

area, 59
bounding box, 58–59
lasso, 59
rotating selections of shapes, 111
Select a candidate shape, 229
Select by Type dialog box, 230
selection handles, 109
shape groups, 129
shapes, 58–59
shapes within containers, 422, 424
shapes within groups, 129, 422, 424
text, 108

Send To Back button (Arrange group), 204
Server shapes, 225
sets, rule, 457, 480
shape data

attributes
changing, 250–256
viewing, 248–250

defining new fields, 256–257
editing, 244–247
linking data to shapes automatically, 272–275
linking diagrams to external data sources, 258–

267
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predefined reports, 275–280
refreshing data in linked diagrams, 267–269
reports

creating new, 281–285
modifying, 287–288

scheduling data refresh, 270–271
types of, 240
viewing, 241–243
Visio Services diagram and, 502
web-published diagrams and, 349

shapes
adding ScreenTips/comments to, 118–123
adding text to, 104–105
adding to lists, 431–434
aligning/spacing, 204–208
annotating with callouts, 448–452
applying fill colors and patterns to, 222–228
applying line styles/colors to borders, 231–235
assigning to layers, 135–139
on borders of containers, 430
connecting 1-D to 2-D, 75–79
connecting with dynamic connectors, 80–85
connecting with lines, 75–80
copying formatting between, 235–236
copying/pasting/duplicating, 60–63
creating custom, 529–531
creating graphic image types from, 330–335
creating with drawing tools, 57–58
defined, 35
determining names of, 304–305
displaying text on or near. See data graphics
aligning with Dynamic Grid, 54–58
grouping, 126–130
identifying 1-D, 85–86
inserting fields onto, 125–126
linking to data. See linking diagrams to external 

data sources
organizing in network diagrams, 363–364
organizing with containers, 425–427
orienting on pages, 108–112
orienting text in, 112–114
positioning with rulers/guides, 63–66
replacing, 95–96
resizing/repositioning, 66–75
rotating, 108–112

selecting, 58–59
selecting in groups, 422
shape data

linking fields to, 125–126
Shape Data window, 213, 478
using, 122–124

Shape Information pane (SharePoint), 501
Shapes group (org charts), 189–191
Shapes window, 39–44
shape text, 383
ungrouping, 130

ShapeSheet, viewing/modifying, 534–537
Shapetacular org chart style, 195
Share page (Backstage view), 23–24
SharePoint 2013

saving Visio drawings to, 495–502
SharePoint Designer, 473–474
Visio Services. See Visio Services (SharePoint 

2013)
workflow diagrams

basics, 472–475
creating, 475–478

sharing. See also coauthoring; commenting
diagrams with Visio Viewer, 343–344
Visio templates, 338–340

sheet
defined, 304
finding shape names, 304–305

Shelf shape, 372
Show group, 123
show/hide

External Data window, 29
photos (org chart), 179
Shape Data window, 29, 243
subordinates (org chart), 189

Show Only Drawing-Specific Reports option, 280
Shrink Font button, 106
Silverlight, Microsoft, 345
Simple thumbnail, 232
sizing

containers, 429–432
fonts, 106–107
lists, 435
Size & Position window, 66, 75, 80, 127
text boxes, 107
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Snap and Glue property (layers), 135
Sort dialog box (reports), 283
Sort key field, 250
Spacing Options dialog box, 55, 211
spacing shapes, 204–208
Standard Colors, 224
Standard tab (Colors dialog box), 228–229
Start/End shapes, 86, 170
start page (Visio 2013), 14–15
static glue

1-D shape behavior and, 85–86
about, 81
connecting shapes with, 81, 83

status bar
overview, 37–39
width/height of shapes displayed in, 150

stencils
creating custom, 529–531
defined, 35
Quick Shapes section, 89
in Shapes windwow, 36

storing
custom templates, 341–342
Visio-generated website files, 493

string (shape data field type), 240
styles

container, 419, 428
Styles button (Mini Toolbar), 216
Style Sheet setting (Save As Web Page dialog 

box), 493
subprocesses

Create from Selection button, 468
Create New button, 472
in flowcharts/diagrams, 468–472
Link to Existing button, 472
Subprocess shapes, 92

SVG images
creating from Visio drawings, 330, 335
webpage output format, 492

swimlane diagrams
containers/lists and, 436–441
creating, 167–173
overview, 166

Switch Windows button (status bar), 39
System Setting format, 252

T
tabs (Visio ribbon)

add-in, 33
customizing, 525–526
regular, 27–30
tool, 32

Target Monitor setting (Save As Web Page dialog 
box), 493

TaskMap add-in, 33
Task Panes button (Show group), 123
Task Shape (BPMN), 463
templates, Visio

BPMN, 462
categories of, 18
defined, 35
featured, 17
locating in Visio 2013, 15
metric vs. US units, 19
for predefined business rules, 457
predefined reports and, 275–280
saving drawings as, 338–340
searching, 14–15
Standard edition vs. Professional edition, 4
storing custom, 341–342
Wireframe, 442

text
adding to shapes, 104–105
Bubble Callout style, 402
on connectors, 111
displaying on or near shapes. See data graphics
orienting in shapes, 112–114
repositioning within text blocks, 114–117
resizing text blocks, 116
searching/replacing, 382–386
Text Annotation shape, 466
Text Block tool, 113–114, 115
text boxes, creating/formatting, 105–108
Text Tool, 105, 108
TxtAngle cell, 113

themes
adding to org charts, 191–192
applying to diagrams, 212–218
copying, 221
customizing, 218–219
hand drawn, 220



568    Three Positions shape, 177

setting options for, 221
Theme Colors, 224
THEME() function (ShapeSheet), 536
Themes gallery, 108, 214

Three Positions shape, 177
TIF images, creating from Visio drawings, 330, 335
Tight Reflection effect, 230
Tiles thumbnail, 152
Title/Date shape, 197
Tools group, 105
tool tab sets (ribbon), 32
Trust Center

about, 27
macro security in, 540–541

two-dimensional shapes
connecting with dynamic connectors, 80–85
connecting with lines, 75–80
defined, 75

Type attribute (shape data fields), 249

U
Undo button (Quick Access Toolbar), 188
Undo feature, 94
ungrouping shapes, 130
Updates Available prompt (coauthoring), 519
upgrading

from Visio 2003, 8–9
from Visio 2007, 6–8
from Visio 2010, 5–7

Upper tab item shape, 444
Use Relative Path For Hyperlink check box, 308, 310
US Units diagrams, 19

V
validating

BPMN diagrams, 464–467
creating new validation rules, 481–482
flowcharts, 457–461
reusing existing validation rules, 479–482
Rules Tools software, 482

Value attribute (shape data fields), 249

variable list (shape data field type)
about, 240, 247
using, 254–255

variants
applying to diagrams, 212–218
Variant Colors, 224
Variants gallery, 218

VBackground-1 page, 152
VBA (Visual Basic for Applications), 481, 541–542
VBE (Visual Basic Editor), 542
VDW file format, 336
VDX file format, 545
vertical lists, 434
viewing

shape data, 241–243
shape data attributes, 248–250
View tab

ribbon, 30–31
Show group, 123
Zoom group, 108

Visio Viewer, 343–344
Visible property (layers), 135
Visio 2013

Backstage view. See Backstage view
editions of, 4
file formats, 544–545
flow charts in Standard edition, 158–159
linking between Visio pages, 302–303
new features in, 4–9
programming with VBA, 541–542
Save As file formats, 336–337
start page, 14–15
upgrading to. See upgrading
Visio SDK, 542
Visio Web Access browser view, 494

Visio 2013 Professional
data graphic legends, 447–448
flowcharts in, 159–160
refreshing data in linked diagrams, 267
scheduling data refresh, 270
Visio 2010 Web Drawing option, 335



 XPS format, exporting files as, 338    569

Visio Services (SharePoint 2013)
basics, 494–495
Business Intelligence in Microsoft SharePoint 

2013 (Microsoft Press), 495
refreshing diagrams published to, 503–510

Visual Basic for Applications (VBA), 541–542
VML webpage output format, 492
VSDM file format, 336, 544–545
VSDX file format, 336, 544–545
VSSM file format, 336, 544–545
VSSX file format, 336, 544–545
VSTM file format, 336, 544–545
VSTX file format, 336, 544–545

W
web

hyperlinks, establishing base for, 313
publishing diagrams to, 344–351
webpage formats, 491

websites
linking to, 294–296
Visio websites

content and location of, 493
customizing, 486–492

websites for downloading
Microsoft Active Directory Topology 

Diagrammer add-in, 386
modified PC Report definition, 382
server and network shapes, 362
Visio stencils, 375–376

websites for further information
AutoConnect, 91
BPMN, 463
BPMN template features, 462
callouts, 452
containers/lists/callouts, 425
customizing ribbon tabs, 527
customizing server shapes, 363
Developer tab functions, 534
lists, 435
Microsoft quick start guides, 15
PowerPoint slides, creating from Visio drawings, 

542
rule development, 482

Rules Tools, 482
ShapeSheets, 537
Stencils/Masters/Shapes, 532
structured diagram components in VBA, 544
swimlane containers, 441
TaskMap add-in, 33
text block positioning, 117
validation rules, 481
VBA programming, 542
viewing Windows disk drive as org chart, 201
Visio 2013 file format reference, 545
Visio guide, 30
wireframe design, 447
workflow capabilities in SharePoint, 473

Whisp theme, 214–215
Width/Height buttons (status bar), 127
width of ribbon, 10–12
wireframe shapes, 441–446
WMF images, creating from Visio drawings, 330, 

335
Word, Microsoft

linking to document locations, 301
Microsoft Word 2013 Step by Step (Microsoft 

Press), 301
named bookmarks in, 299

workflow diagrams
SharePoint

basics, 472–475
creating, 475–478

Work Flow Diagram template, 158
Work Flow Diagram thumbnail, 127

workspace, 35
wrapping text (text boxes), 107

X
XAML (Extensible Application Markup Language), 

486
X-axis positioning, 204
XML (Extensible Markup Language)

report output format, 277
in Visio 2013 file formats, 544–545
in Visio-created websites, 493
in XPS document format, 337

XPS format, exporting files as, 338



570    Y-axis positioning, 204

Y
Y-axis positioning, 204
yellow control handles, 71

Z
Z-axis positioning, 204
zooming

and panning, 45–51
to relocate/rotate text, 117
Zoom setting, 303
Zoom To Fit Page To View button, 501

Z-order, 204, 206
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